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Getting Started



Workshop In the Getting Started module you will build the flowsheet around which most of the rest of this course is based. The process is a Turbo Expander plant. LPG Product is obtained from a Feed Natural Gas stream by cooling, expanding, separating and distillation. The remaining gas is then re-compressed for export.



Learning Objectives Once you have completed this section you should have revised your basic HYSYS knowledge. You will also be able to: • • • • •



Use the HYSYS LNG Exchanger to simulate multi-pass exchangers Add Columns using the Input Experts Add extra specifications to columns Customize the Workbook and PFD Use stream property correlations



Prerequisites This course is aimed at people who have had some experience of using HYSYS before. Hence the instructions are deliberately brief in places where previous HYSYS users are likely to already know what to do. If you have problems at any stage you can ask the course instructor.
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Process Overview



Column Overview
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Building the Simulation Some stream and operation names can be obtained by referring to the PFD at the start of this section.



Defining the Simulation Basis 1.



Start a new case using the Peng Robinson Equation of State.



2.



Use the following components: Nitrogen, CO2, Methane, Ethane, Propane, i-Butane, n-Butane, i-Pentane, n-Pentane and Hexane.



3.



Enter the Main Simulation Environment.



Add the Feed Gas Stream 4.



The Feed Gas stream has the following conditions and composition:



Name



Feed Gas



Temperature



30°C (86°F)



Pressure



5000 kPa (725.19psia)



Flow rate



2988 kgmole/h (6587.3 lbmole/hr)



Component



Mole Fraction



Nitrogen



0.0149



CO2



0.002



Methane



0.9122



Ethane



0.0496



Propane



0.0148



i-Butane



0.0026



n-Butane



0.002



i-Pentane



0.001



n-Pentane



0.0006



n-Hexane



0.0003
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Add the Multi-pass Exchanger Multi-pass exchangers are known as LNG Exchangers in HYSYS. LNG icon



The LNG (Liquefied Natural Gas) exchanger model solves heat and material balances for multi-stream heat exchangers and heat exchanger networks. The solution method can handle a wide variety of specified and unknown variables. The LNG allows for multiple streams, while the HEAT EXCHANGER allows only one hot side stream and one cold side stream.



The Tube Side and Shell Side streams can come from different Flowsheets. This is one way of using different fluid packages on each side of the exchanger



For the LNG exchanger, you can specify various parameters, including heat leak/heat loss, UA or temperature approaches. Two solution methods are employed; in the case of a single unknown, the solution is calculated directly from an energy balance. In the case of multiple unknowns, an iterative approach is used which attempts to determine the solution that satisfies not only the energy balance, but also any constraints, such as temperature approach or UA. 5.



Add a LNG operation.



6.



Select the Connections page on the Design tab and enter the following information: Figure 1



Any number of Sides may be added simply by selecting the Add Side Button. To remove a side, select the Delete Side button after positioning the cursor in the appropriate row.
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If you prefer you can add the other streams to the flowsheet manually. Alternatively typing the name of a new stream into the Sides box will create it. For each exchanger side: • • •



7.



An inlet stream and outlet stream are required. A Pressure Drop is required. The Hot/Cold designation can be specified. This will be used as an estimate for calculations and will also be used for drawing the PFD. If a designated hot pass is actually cold (or vice versa), the operation will still solve properly. The actual Hot/Cold designation (as determined by the LNG) can be found on the Performance tab in the Results page. Switch to the Parameters (SS) page. These values will be left unchanged. Figure 2



The Weighted method is required for exchangers with more than two sides.



The Exchanger Design (Weighted) method is used to split the heating curves into intervals. (Rather than simply considering the end points) The number of intervals is set in the Exchange Details table. The Step Type parameter sets whether HYSYS splits the curves by temperature, enthalpy or automatically to minimise the errors. By ticking the Dew/Bub pt. checkboxes HYSYS will include points on the heating curves for any phase changes that occur. The Press. Profile options set how HYSYS decides the pressure profile while iterating.
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Heat Losses will not be considered. All streams on the same side with the Equilibrate checkbox checked are considered to be in equilibrium before entering the exchanger calculations. Thus the driving force will be reduced. These options are discussed in more detail in the HYSYS Operations Guide. This is a good time to learn how to access/search the Acrobat PDF documentation.



8.



Go to the Specs (SS) page.



Two extra specifications (in addition to the Heat Balance spec - i.e., conservation of energy) will be added. Just after the streams have been added the Degrees of Freedom display shows 6 (i.e., 7 unknown variables, 1 constraint so far). By adding two new specs this is reduced to 4. Later on when more of the flowsheet is built, these 4 degrees of freedom will be used up and the exchanger will have enough information to solve. Figure 3



The two specs that will be added are: • •
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Cold Stream Outlet temperatures are the same (0°C or 32°F) Minimum approach temperature in the exchanger (10°C or 50°F)
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Add these two specs as follows: Figure 4



LNG exchangers, like normal HYSYS Heat Exchangers and Columns, allow the user to enter as many specifications as required. Only the active specifications are used to solve the operation. If the Est. checkbox is checked then HYSYS will use the spec value as an initial estimate in its iterative solution. Hence specifications can be used for more than just being an active spec. They can: • •



Provide an initial estimate only (Uncheck Active, Check Est.) Be used to monitor how important variables change as the operation iterates (Uncheck Active and Est.)
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Add a Cooler 10. Add a Cooler to stream 1A. This should have the following parameters: Name



Note that in a later module the Cooler operation will be linked to a HYSYS subflowsheet that represents an ethane/propane refrigeration loop.



E-100



Cooler Outlet



Stream 2



Pressure Drop



20 kPa (2.9psia)



Outlet Temperature



-62°C (-79.6°F)



Energy



Q-100



The Cooler outlet Stream 2 should now be fully defined.



Add a Separator 11. The Cooler product Stream 2 should be sent to a Separator vessel. 12. The liquid product is Stream 4 and the vapour product is Stream 3.



Add an Expander 13. The Separator vapour is then expanded to 2800 kPa. 14. The outlet is Stream 5. 15. The Expander should have the following properties: Name
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K-100



Outlet Pressure



2800 kPa (406 psia)



Adiabatic Efficiency



75% (This is the default)



Energy



QK-100
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Add a Separator 16. Add another Separator to the Expander outlet. 17. The feed is the outlet from the Expander. 18. The vapour product is Stream 7 which has already been added and linked to the LNG exchanger. 19. The liquid product is Stream 6.



Add a Valve and Set 20. The liquid from the first Separator is flashed down to the same pressure as the Expander outlet. Add a HYSYS Valve operation to do this. 21. The valve outlet is Stream 8. When the simulation is manipulated later the Turbo Expander outlet pressure is one of the process parameters that will be changed, hence it makes sense to link these parameters within HYSYS rather than manually changing both. This is done using a HYSYS Set operation. This relates two HYSYS parameters. It can be used to make them identical or to force a fixed Multiplier and Offset between them. 22. Install a Set with the following parameters: Name Set icon



SET-1



Target Variable



Stream 8 Pressure



Source



Stream 5



Multiplier



1



Offset



0 kPa (0 psia)
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Figure 5



LPG Recovery Column This will be simulated using the HYSYS Distillation Column operation. This column has 5 stages, a Condenser and a Reboiler. Stream 8 is fed to the top tray and stream 6 is fed to the Condenser. Rather than defining the column pressures within the column operation, as would be normal practice, HYSYS Set operations will be used to relate the column top and bottom pressures to the Turbo Expander outlet stream. The purpose of this is to allow the flowsheet to be manipulated later by changing several key process parameters (including the Turbo Expander outlet pressure).



Set the Column Pressures 23. First add the bottoms liquid product stream to the PFD. (Stream 10). 24. Install a Set operation to ‘Set’ the pressure of Stream 10, so that it is the same as Stream 5. 25. Install another Set to make Stream 9’s pressure 5 psi less than Stream 5’s.
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If psi is not the pressure unit HYSYS is currently using you can enter a psi value by using the unit drop-down to the right for the number entry field. Figure 6



Add the Column 26. Add a Distillation Column operation.



The Input Experts provide the new user with step-bystep instruction for defining a column. They can be switched off in the HYSYS Preferences.



By default HYSYS includes an ‘Input Expert’ to guide the user through setting up the column. The Input Expert has four pages, you must enter all the required information on each page, before the Next > button will become active. 27. Double-click the Column PFD icon to start the Input Expert. 28. Enter the following information on the Connections page: Connections



Distillation Column icon



Column Name



LPG Recovery



No. of Stages



5



Feed Stream / Stage



8 / at stage 1



Condenser Type



Full Reflux



Overhead Vapour Product



9



Bottom Product



10



Condenser Energy Stream



Q-102



Reboiler Energy Stream



Q-103
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29. Since the product stream pressures have already been set (with the Set operations), the Pressure Profile page automatically picks these up. Go to the Optional Estimates page by clicking the Next > button. Temperature estimates are used to help the column come to a solution. If you already have an idea of the conditions in the column (e.g. if you are modeling an existing plant) then you can enter the information. In this case the temperatures are not known, so these estimates will be left blank. 30. Click the Next > button to move to the final page.



Once the Input Expert has been completed it cannot be accessed again unless the column is deleted and added back. However all the information that was entered can be changed using the column property view.
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The final page of the Column Input Expert always has some typical specifications for the particular type of column. In this case, different specifications will be used. These must be added after the Input Expert has been completed. 31. Click the Done button to complete the Input Expert. The Column Property View will now appear. Figure 7
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Before the column is ready to run, some more information must be entered: • Additional Feed Stream • New Specifications 32. Connect Stream 6 up in the Inlet Streams box. Stream 6 should enter the Condenser. 33. Go to the Monitor page on the Design tab. The existing column specs are visible. Figure 8



Since no values were entered for the Specs in the Input Expert, no values are present here. Note that since the column has fully defined feeds, the pressures are known, and 2 specs are activated the Degrees of Freedom display is showing 0. This column will actually be solved to two different specifications. • •



Condenser Duty of zero. Stream 6, the cold expanded liquid stream, enters the condenser so provides the necessary cooling effect. LPG product RVP (Reid Vapour Pressure) specification.
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34. Add these two specs as follows: First Spec RVP (Reid Vapour Pressure) is a volatility measure commonly used in the Refining industry. It is the pressure at which the vapour and liquid have a 4:1 volume ratio at 100°F.



Type



Column Duty



Name



Ovhd Duty



Energy Stream



Q-102 @ Col1



Spec Value



0.001 kJ/h



Second Spec Type



Column Vapour Pressure Spec



Name



Btms RVP



Stage



Reboiler



Type



Reid Vapour Pressure



Phase



Liquid



Spec Value



200 psia



An estimate of the column overhead vapour rate will also be provided. One of the specs already added by HYSYS will be used. 35. Modify the existing Ovhd Vap Rate spec as follows: Existing Vent Rate Spec Name



Ovhd Vap Rate



Draw



9 @ Col1



Flow Basis



Molar



Spec Value



1600 lbmole/hr



36. Ensure the Ovhd Duty and Btms RVP specs are set to be Active and Estimates, and that the Ovhd Vap Rate spec is set as an Estimate. The other unused specs can be deleted by going to the Specs (SS) page on the Design tab and pressing the Delete button, or by double-clicking the spec on the Monitor page on the Design tab and clicking Delete.
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37. If the column hasn't run automatically, click the Run button. You should see some messages in the Trace Window (bottom right white pane) as the column solves. When the column has solved, the LNG should then be solved as now both Streams 7 and 9 are fully defined. What is the flow rate of the Overhead vapour stream?



Was the ‘Vent Rate’ estimate a good one?



Completing the Simulation The simulation is now almost complete. The two product gas streams from the LNG must be mixed and re-compressed for export. 38. Mix Stream 7A and 9A using a Mixer operation. The outlet is Stream 11. 39. Add a Compressor, keep the standard Adiabatic Efficiency of 75%. The outlet is Stream 12 and the energy is QK-101. 40. Install another Set to link the heat flow of the compressor energy stream (QK-101) to the Expander energy stream (QK-100). 41. Add another Cooler to cool the mixed compressed gases to 30°C. The Cooler has a 0.2 bar pressure drop. 42. Finally, install an Export Gas Compressor to take the product gas to 70 bar. The compressor has an Adiabatic Efficiency of 75%.



Save your case!
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Compressor Degrees of Freedom In this HYSYS case there are two compressors specified differently: • •



K-101 has a fully specified inlet stream and a specified duty. K-102 has a fully specified inlet stream and a specified outlet pressure.



HYSYS can also solve for a flow rate given an otherwise fully specified feed stream, a duty and an outlet pressure. Additionally HYSYS compressors can be supplied with head and efficiency curves. This is covered in a later module.



Advanced Modeling The Column is a special type of sub-flowsheet in HYSYS. Sub-flowsheets contain equipment and streams, and exchange information with the parent flowsheet through the connected streams. From the main environment, the Column appears as a single, multi-feed multi-product operation. In many cases, you can treat the Column in exactly that manner. The Column Sub-flowsheet provides a number of advantages: • The presence of the green ‘Up Arrow’ icon in the Button Bar and the Environment: Name (COL1) indicates that you are in the Column Subflowsheet.



•



The Object Palette is different in the Column Subflowsheet.



•
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Isolation of the Column Solver - The Column Build Environment allows you to make changes and focus on the Column without the re-calculation of the entire flowsheet. Optional use of different Fluid Packages - HYSYS allows you to specify a unique (different from the Main Environment) fluid package for the Column Sub-flowsheet. This may be useful in instances when a different fluid package is better suited to the Column (Gas Plant using PR may contain an Amine Contactor that needs to use the Amines Property Package), or the Column does not use all of the components used in the Main Flowsheet and so by decreasing the number of components in the column you may speed up column convergence. Construction of custom templates - In addition to the default column configurations, which are available as templates, you may define column set-ups with varying degrees of complexity. Complex custom columns and multiple columns may be simulated within a single sub-flowsheet using various combinations of SubFlowsheet equipment. Custom column
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Enter Parent Simulation Environment icon



•
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examples include, replacement of the standard condenser with a heat exchanger, or the standard kettle reboiler with a thermosyphon reboiler. Ability to solve multiple towers simultaneously - The Column Sub-flowsheet uses a simultaneous solver whereby all operations within the sub-flowsheet are solved simultaneously. The simultaneous solver permits the user to install multiple interconnected columns within the sub-flowsheet without the need for Recycle blocks.



You can enter the Column Sub-flowsheet by clicking the Column Environment button on the Column Property View. Once inside the Column Environment you can return to the Parent Environment by clicking either the Parent Environment button on the Column Runner view or the Enter Parent Simulation Environment button in the Button Bar.



Customizing the Workbook and PFD HYSYS allows the user to customize the Workbook and PFD.



Customizing the Workbook 43. Show the workbook by pressing the Workbook button on the toolbar (or by using the Workbook option on the Tools menu). Workbook button
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44. From the Workbook menu, select Setup. The Setup view appears as shown below: Figure 9



The left side of this section allows you to add new tabs to the Workbook. The right side allows you to configure the properties that appear on each tab. 45. Add a new Workbook tab. Choose the object type to be StreamMaterial Stream on the window that appears. 46. Change the tab Name to Other Props. 47. Change the tab to show the following variables: Molecular Weight, Mass Heat Capacity and vapour phase Cp/Cv.



Phase specific properties all start with 'Phase…' in the alphabetical variable list.
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By using the Order/Hide/Reveal Objects option on the Workbook menu it is possible to customize which objects appear on each tab. 48. Change the Other Props tab so that it displays only the terminal streams (Feed Gas, Export Gas and 10).
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Customizing the PFD For each flowsheet, HYSYS allows multiple PFD views to be configured. These PFDs are just different views on the same set of objects, so deleting a stream from one PFD will mean it is deleted from all the PFDs. Using multiple PFDs allows various possibilities: • •



Creation of a 'Presentation' PFD that has some streams/ operations hidden to produce a PFD ready for output. Define a number of views on the same flowsheet (e.g. a zoomed out view and a number of views zoomed in to particular areas of the process).



When using multiple PFDs it is a good idea to have one 'working' PFD that shows all the streams and operations. 49. Create a PFD named Presentation using the Add a PFD option from the PFD menu. Choose to Clone the existing PFD. Figure 10



To unhide objects that have been hidden, right-click on the PFD background and choose Reveal Hidden Objects.



50. Hide all the Set operations on the Presentation PFD by right-clicking on their PFD icons and choosing Hide on the object inspect menu. 51. Add a PFD workbook table for the Other Props Workbook tab by object inspecting the PFD background and choosing the Add Workbook Table option.
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Customizing Stream Properties The Properties page of the material stream property view can be customized. Figure 11



The user can: • • •



Add or remove properties (these are also referred to as Property Correlations) Change the order of properties Save sets of property correlations and apply them to other streams, or to the whole case



There are two places in HYSYS that these correlations are controlled: • •
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Property Correlation Controls section on the stream Properties page – Allows the correlations for an individual stream to be customized. Also allows sets of correlations to be saved. Correlation Manager on the Tools menu – Allows changes to be made to the property correlations in use for the whole case.
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The property correlations displayed for a particular stream are controlled using the buttons at the bottom of the stream window on the Properties page. Figure 12



These have the following functions: Button



Flyby Text



Notes



View Correlation Set List



Allows the user to pick from a list of previously defined correlation sets.



Append New Correlation



Brings up a window where all correlations are displayed in a tree, and can be selected and added. Correlations are added to the bottom of the list.



Move Selected Correlation Down



Move Selected Correlation Up



Sort Ascending



Remove Selected Correlation



Remove All Correlations



Save Correlation Set to File



The Correlation Set can then be loaded with the View Correlation Set List function.
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View Selected Correlation



See settings specific to the selected correlation.



View All Correlation plots



See all correlation plots for the stream. Currently greyed out as none of the correlations have plots.



1.



Open the property view of the Feed Gas stream. Click the Remove All Correlations button to clear all the correlations from the stream.



2.



Using the Append New Correlation button, add the following properties: • • • • •



Don’t forget to click Apply to add these properties.



Gas - HC Dew Point Gas - Higher Heating Value Gas - Lower Heating Value Gas - Wobbe Index Standard - Act. Volume Flow



Figure 13



By clicking the blue stream arrow button next to the stream name, a different stream can be selected.



3.
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On the Feed Gas stream Properties page, select the Higher Heating Value [Gas] row in the table.
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Click the View Selected Correlation button. Figure 14



Property correlation parameters can only be edited using the Correlation Manager. The meaning of the Status group is explained below.



A window appears giving details of the property, note that here the Reference temperature option cannot be changed (i.e., it appears in black).



If the existing correlations are not first removed, then any new ones in the Correlation Set are added to the bottom of the list.



5.



Click the Save Correlation Set to File button to save the properties in this stream as a correlation set called Gas CorrSet.



6.



Open the Properties page for the Export Gas stream. Remove all the existing correlations and add the Gas CorrSet correlation set to the stream using the View Correlation Set List button. Figure 15



All user defined correlation sets are stored, by default, in the file StreamCorrSets.xml in the \Support subdirectory of the HYSYS 25
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installation. The name and location of this file can be configured on the Files-Locations page of the Preferences window (Tools-Preferences menu option). This file is not created until a correlation set is added.



Customizing Properties for the Whole Case HYSYS includes a Correlation Manager where global changes for the whole case can be made. This is accessed from the Tools-Correlation Manager menu item. Figure 16 Details of the selected correlation



Add or Remove Correlations



Load in a previously saved Correlation Set



Streams displaying the selected correlation



The meaning of the Stream Correlation Controls (Global) buttons are similar to those for the individual stream, except any changes apply globally (i.e., to all the streams in the case). The functions of the buttons are as follows: Button



Flyby Text Scan System Correlations
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Notes Click this icon to manually scan the system registry and build a list of available property correlations.
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Clone Selected Correlation



Only enabled when a property with variable parameters is selected (details are given in the following sections).



Delete Cloned Correlation From List



Only enabled when a previously cloned property is selected in the Clone part of the tree, and when no streams are showing the property.



Activate Selected Global Correlation



Adds the selected property correlation to all the streams in the case.



Remove Selected Global Correlation



Removes the selected property correlation from all the streams in the case.



Remove All Global Correlations



Removes all the property correlations from all the streams in the case.
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Some properties (like the Higher Heating Value property viewed above) have user adjustable parameters. 1.



Open the Correlation Manager using the Tools menu.



2.



Select the Gas-Higher Heating Value property in the tree. The right side of the window now shows a similar view to that seen previously. However, now the reference temperature can be changed.



3.



Change the reference temperature and note that the values calculated in the Feed Gas and Export Gas streams change.



When you change a correlation’s parameters, all the streams displaying the correlation will use the new parameters. Hence HYSYS has a clone feature that allows multiple copies of the same correlation to be used. Cloned correlations can have different parameter values to the original correlation. Note that now the cloned Higher Heating Value correlation is now present in all the streams in the case.’ Cloned correlations can be renamed by typing a new value into the Display Name cell.



4.



Click the Clone Selected Correlation button to clone the Higher Heating Value property.



5.



Find the new cloned property in the Clone section of the tree.



6.



Add this correlation to all the streams in the case using the Activate Selected Global Correlation button.



7.



Set the reference temperature for the cloned correlation so that it is different from the original correlation.
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Compare the values of the two correlations for the Feed Gas and Export Gas streams. Figure 17



The following table describes the six bars contained in the Status group: Status Bar



Description



Stream



Indicates that the correlation can only be applied to material streams.



Point/Plottable



Indicates whether the property correlation is a point or plottable property.



Black Oil/Electrolyte/ Gas/RVP/Solid/ Standard/User/Clone



Indicates which correlation type the property correlation resides within in the Available Correlations list.



Active/Inactive



Indicates whether the property correlation has been activated by the correlation manager. If the status bar is green, any new stream added to the flowsheet with the same fluid type as the correlation will automatically have the property correlation added.



View Global Correlation Set List button
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In Use/Not in Use



Indicates whether the property correlation is being used by a stream in the case.



Available/Unavailable



Indicates whether the property correlation exists in the window registry of the system.



The View Global Correlation Set List button in the Stream Correlation Set Controls (Global) group allows a previously saved Correlation Set to be displayed for all the streams in the case.
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Using the Correlation Manager, remove all the existing correlations for all the streams in the case, then load in the previously created Gas CorrSet Correlation Set so that it is used by all the streams.



Warning Message: Loading a Case When you load a previously saved case, you may see the following message: Figure 18



The wording of this message and the Preferences options are slightly different for HYSYS versions before 3.2, although the effect of choosing each option is the same.



• •



Yes will append the standard set of properties to any streams that may have had properties removed. Any custom properties added will remain. No will leave all stream property views as they were when the case was saved.



In most cases the standard property set will be being used anyway, so it does not matter which option is chosen.
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The HYSYS preferences include several options relevant to this message. Figure 19



• • •



Checking Activate Property Correlations tells HYSYS to add the standard correlations upon opening a case. Checking Confirm Before Adding if Active Correlations are Present makes HYSYS show the previous message when every case is loaded. Unchecking Confirm Before Adding if Active Correlations are Present is equivalent to clicking Yes each time the message appears.



The safest choice of options is the default. Unchecking the Confirm Before Adding if Active Correlations are Present is probably worthwhile, unless you are dealing with cases where the correlations have been customized.
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Each stream has a status indicator on the Properties page that indicates whether the Activate Property Correlations option is checked in the Preferences. The Correlation Manager window also has a similar status indicator. Figure 20



9.



Save and close your case.



10. Go to the Simulation-Options page of the HYSYS Preferences (select the Tools-Preferences menu option). 11. Ensure that the two checkboxes in the Stream Property Correlations group are activated. 12. Reload the case. Click Yes on the message box. Notice that all the streams in the case now have the standard set of correlations in addition to any customizations. 13. Reload the case again. Click No on the message box. Notice that now the streams only show the correlations in the Gas CorrSet correlation set.
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Extensions



Introduction One of the most powerful features of HYSYS is that users are able to create and add their own unit operations to the program through extensibility. In this module, the power of this feature will be demonstrated, however the process required to build an extension in HYSYS will not be covered. If you want to learn more about creating unit operation extensions or other tools, using the extensibility feature of HYSYS; AspenTech offers another course that will meet your needs. For more information, ask the instructor. With unit operation extensions users can create models for unit operations that are not available in HYSYS. Unit operations can also be used to perform calculations, much like the depressuring utility also examined in this course. The Virtual Stream extension to be used in this module allows the user to transfer information from one stream to another, creating a “Live Link” between them.



Learning Objectives By completing this module, you will learn how to: • •
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Register extensions in HYSYS. Use a prebuilt extension in a HYSYS simulation.



Extensions
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Registering Extensions Before extensions can be used in a simulation, they must be registered. 1.



Open the Tools menu and select Preferences.



2.



Click the Extensions tab. Figure 1



3.



Click the Register an Extension button. The Select an Extension to be Registered view appears.
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4.



Navigate to where your extension file is located and double-click it to register it with the system. Figure 2



Once an extension is registered, it will appear on the Extensions tab, and you will be able to use it in your simulation. Figure 3



5.



Close the Session Preferences view.



There is no need to restart your computer, although HYSYS may need to be restarted.
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Adding Extensions to Your Simulations Extensions are added just like any ordinary unit operation in HYSYS. The only difference is that they do not have an icon on the Object Palette. The simplest way to add an extension to your simulation is to follow the steps below: 1.



Press the hot key to bring up a menu of unit operations.



2.



Select the Extensions radio button from the column on the left. The extensions that are registered with the system will appear in a column on the right.



3.



Select the desired extensions and click the Add button. Figure 4



If an extension that has just been registered does not show in the list of available extensions, then restart HYSYS.
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Workshop Don’t worry if you haven’t built the Turbo Expander plant case. You can use the “ADV1_GettingStarted_Soln .hsc” file.



In this workshop, you will add the Virtual Stream extension to various streams in the Turbo Expander case built in the Getting Started module. The files for this extension (VirtualStream.dll, VirtualStream.edf and Virtual Stream User Guide.doc) have been supplied to you on the course disk. In addition to this extension, there are several others available on the AspenTech support website (support.aspentech.com). 1.



Copy these files to a location on the computer's hard disk.



It is not important where on the hard disk you copy these files, but remember the location as you will need to find these files in order to register them with the system.
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2.



Once the files have been copied to the hard disk, move to the Extensions tab of the Preferences view. (Accessed through the Tools menu in the main menu bar.)



3.



Click the Register an Extension button, and use the file explorer to locate the VirtualStream.dll file. Opening this file will register it with the system and allow you to use it in the simulation.



4.



Return to the PFD of the simulation and add the extension using the procedure described previously.



5.



On the extension’s Connections tab, use the drop-down list to select the Reference stream as Feed Gas, and for the Target Stream create a new stream called Feed Gas VS.



Extensions
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If the Feed Gas stream doesn't appear in the Reference stream dropdown then the Allow Multiple Stream Connections option must be set in the preferences (Tools-Preferences menu). Figure 5
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Extensions



6.



On the Parameters tab, configure the extension to transfer the Pressure, Molar Flow and Composition, with a specified Target Vapour Fraction, as below. Figure 6 Tick checkboxes to transfer information to Target Stream.



Specify Multiplier and Offset for transferred variables.



Type Target value for any remaining degrees of freedom.



This means that stream Feed Gas VS automatically maintains the same Pressure, Molar flow, and composition as the Feed Gas stream, but will always have a vapour fraction of 0. In this way, the temperature of Feed Gas VS is always the bubble point of stream Feed Gas.



Challenge Connect to the web and investigate the additional extensions available within the Sample Macros and Extensions section of the Knowledgebase on the AspenTech support web page at http:\\support.aspentech.com. In order to access the Knowledgebase you will need to have previously registered and obtained a login ID. These can be downloaded and registered in exactly the same way as the Virtual Stream extension. Alternatively you may have some others already stored on your company network or your computer.
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Advanced Columns



Workshop Most users are familiar with the prebuilt columns that are available in the main HYSYS Environment. This module will introduce the concept of custom columns. HYSYS allows users to build columns without using the prebuilt configurations. This is useful for simulating columns that do not fit into the usual configurations. Building custom columns allows users to replace reboilers with heat exchangers; the heat exchangers can then be rated and sized. Likewise, thermosyphon reboilers can be used in place of generic reboilers. HYSYS also includes a Column Sizing utility that can size and rate column tray sections.



Learning Objectives After completing this module, you will be able to: • • •



Build custom columns in HYSYS Replace generic reboilers with sizable heat exchangers Perform Tray Sizing and Rating calculations



Prerequisites Before beginning this module, you should be able to: • • •
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Navigate the Main Simulation Add unit operations to the PFD Add, and converge, a generic prebuilt column



Column Overview
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Custom Columns The most common way of adding a column to a simulation is to use the prebuilt columns that HYSYS offers. There are four prebuilt columns available: • • • •



Absorber - the simplest of all towers, no reboiler or condenser. Refluxed Absorber - an absorber tower with a condenser on the top stage that allows for a refluxing stream in the column. Reboiled Absorber - an absorber tower with a reboiler at its base, and no condenser at the top. Distillation Column - an absorber tower with both a condenser and a reboiler.



Customising a Column gives the user greater control over the simulation. For example, replacing the reboiler with a Heat Exchanger allows the user to use steam as a heating medium and size the exchanger based on the required duty. Custom Columns can be built in two ways, either by modifying a prebuilt column, or by constructing a new column from the beginning. In this module, a prebuilt LPG recovery column will be modified.



The Column Sub-Flowsheet Whenever a column is added to a HYSYS simulation, a Column Subflowsheet is created. The sub-flowsheet is essentially another layer in the HYSYS simulation. It is located under the Main layer, and can be seen by selecting Tools-PFDs in the main menu bar, or by pressing the hot-key CTRL P. The nature of the layering scheme can be seen in the displayed list as the Column's PFD is indented under the Main PFD. Selecting the desired PFD and clicking the View button will open that particular layer for viewing. In HYSYS Version 3.1+ it is not necessary to enter the Column Environment to edit it. Changes can be made by opening the PFD and editing it, although it is still recommended to enter the Column Environment.
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Alternatively the PFD of a particular column can be seen by right clicking on the column PFD icon and choosing Open PFD. In order to edit the column, i.e. to add and modify operations, it is best to enter the Column Environment. The Column Environment is accessed through the Column Property View. To bring up the Column
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Property View, double click the column icon on the PFD. With the Column Property View as the active view, click the Column Environment button. This will make HYSYS enter the Column Environment. The operations within the column can be deleted, modified, replaced, and controlled just like ordinary unit operations in the Main Environment.



Enter Parent Environment icon



When in the Column Environment, returning to the Main Environment can be accomplished by clicking the Enter Parent Simulation Environment icon located on the Main Menu Bar. Adding operations to the column is very similar to adding operations in the Main Environment. The choice of operations is reduced, but the method of installation is identical.



Building the Simulation Don’t worry if you haven’t built the Turbo Expander plant case. The file “ADV1_GettingStarted_Soln .hsc” contains this case.



This module will continue with the column built in the Getting Started module. This column is an LPG Recovery unit for a Turbo Expander plant. This column was constructed as a generic distillation column. The condenser is a “Total Reflux” type; this means that there is no liquid product from the condenser, rather all of the condensed liquid is sent back into the column to provide a refluxing liquid stream. The reboiler on this column is also of the generic type. An energy stream is supplied and the liquid product from the last stage is boiled up. The vapours return to the column and the liquid leaves the column as a liquid product.
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Replacing the Reboiler The generic reboiler will be replaced with a shell and tube heat exchanger. This will allow the user to supply steam to the column as the energy stream, and size, or rate, the heat exchanger. Modified HTSIM Inside-Out is a general-purpose solver that allows Heat Exchangers and other operations in the Column Environment.



1.



Before modifying the column, it is necessary to change the Column Solving Method to Modified HYSIM Inside-Out. The Solving method is accessed through the Solver page (on the Parameters tab) of the Column Property View.



Figure 1



2.



In the Basis Environment, add Water to the list of components.



3.



If necessary click the Run button to recalculate the column.



4.



Enter the Column Environment and delete the existing reboiler and energy stream from the PFD.



Because the generic reboiler that had no pressure drop is being replaced with a heat exchanger that will have a pressure drop, a pump must be added to the simulation to “push” the fluid through the exchanger.
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Add a Pump to the Column Environment with the following parameters:



In This Cell...



Heat Exchanger icon



Enter...



Name



Reboiler Pump



Inlet



To Reboiler



Outlet



Pump Out



Energy



Pump Duty



Delta P (on Design... Parameters page)



75 kPa (10.9 psia)



6.



After the newly created pump, add a Heat Exchanger to the Column's PFD, with the following parameters:



In This Cell...



Enter



Name



E-100



Heat Exchanger Model



Calculated by Column (default)



Tube Side Inlet



Steam In



Tube Side Outlet



Steam Out



Shell Side Inlet



Pump Out



Shell Side Outlet



Reboiler Out



Tube Side Pressure Drop



50 kPa (7.25 psia)



Shell Side Pressure Drop



75 kPa (10.9 psia)



7.
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Define the Steam In stream as saturated pure steam at 200°C (392°F). The mass flow rate is 2500 kg/h (5511 lb/hr).



Normally when the reboiler is deleted from the column Sub-flowsheet the pressure that was specified at the bottom will be lost, and hence must be added back on the Parameters page in Profiles tab. However in this case the pressure at the bottom of the column is set by the pressure in the bottoms liquid product stream (10), which is linked to the Turbo Expander outlet pressure. Be sure to pick the Separator operation from the object palette, rather than one of the Condensers which have similar icons.



8.



Add a Separator after the Heat Exchanger, with the vapour product returning to the bottom stage of the column, and the liquid product leaving the Column Environment as stream 10. (See the Column Overview at the beginning of the module for the column PFD).
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9.



Because the Reboiler was deleted, HYSYS removed the Reboiler liquid RVP spec. Add this spec back:



RVP Spec... Type



Column Vapour Pressure Spec



Name



Btms RVP



Stage



V-100



Type



Reid Vapour Pressure



Phase



Liquid



Spec Value



200 psia



Since the Heat Exchanger was installed in the Column Environment it's specifications appear on the Monitor page along with the specifications of the column. Heat Exchanger specifications can be activated and deactivated just like Column specifications; they can also be added in exactly the same manner as Column specifications. 10. Return to the Main Flowsheet and ensure that the three active specifications for the column are: Ohvd Duty, Btms RVP, and E-100 Heat Balance. Figure 2
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11. Run the column; after it has converged, answer these questions: What is the UA of the Heat Exchanger?



What is the LMTD for this exchanger?



What is the vapour fraction of the outlet steam?



Save your case! Connecting Streams Between Flowsheets 1.



Look at the Main PFD. Notice the streams Steam In and Steam Out are not visible here. This is because they were created in the Column Sub-flowsheet, and have not been connected to the Main Flowsheet.



2.



Streams are connected between the Main and Sub-flowsheet on the Connections page on the Design tab. Notice that there are two types of streams listed here, Internal and External. Internal streams are those on the Column Sub-flowsheet. External streams are the corresponding streams on the main Flowsheet. Currently Steam In and Steam Out do not have any linked external streams.
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3.



Internal streams are connected to the Main Flowsheet by typing a name in the External Stream column. Add the appropriate names to the External Streams column, and check to make sure that these streams appear in the Main PFD.



Figure 3



As this is now a Custom Column, the Connections page of the Design tab no longer shows a Distillation Column.



The Steam In flow rate was defined in the Column Environment, therefore, it is not a specifiable parameter in the Main Environment. Some users prefer to have all the feed streams visible and editable in the Main Environment. 4.



Delete the flow rate of Steam In in the Column Environment, and enter the same value as a flow rate for Steam In in the Main Environment. The column will automatically resolve.



5.



Delete the other Steam In specifications on the column subflowsheet (Vapour Fraction, Temperature and Composition) and transfer them to the main flowsheet.



Save your case!
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Exercise - Simulating the Reboiler on the Main Flowsheet Using Internal Streams Another method of simulating the reboiler with a Heat Exchanger is to use the Internal Stream feature of the column to make a copy of the reboiler on the main flowsheet. Here this will be added to the case where a rigorous heat exchanger has already been added to the column subflowsheet. However this technique works just as well with columns using the standard Reboiler operation. This way of modelling the reboiler is just as accurate as adding the heat exchanger to the column sub-flowsheet although it does not look quite as good. An 'Internal Stream' is a special HYSYS stream that represents a fluid inside the column, for example the vapour leaving the top tray, or the liquid leaving the bottom tray. Internal Streams show with a cyan colour on the column sub-flowsheet.
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1.



Go to the Flowsheet-Internal Streams page of the column, press the Add button and configure the table as below:



Figure 4 Type the name of the internal stream



Stage and Phase the stream will represent



Check this box to make the stream appear on the main flowsheet



Only relevant for streams with external draws. Net = exclude effect of external draws (consider flows in column only) Total = include draws (i.e. total flow leaving the stage)



2.



Re-run the column to calculate the internal stream.



3.



Locate the stream on the main flowsheet, check that its properties are the same as those for the liquid leaving the column.



4.



Add a pump, heat exchanger and steam streams as earlier in the module.



Pump Name Instead of manually adding the streams and operations you can copy & paste them from the column subflowsheet by using the rightclick copy/paste options.
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Reboiler Pump



Inlet



Btm Tray Liquid



Outlet



Pump Out



Energy Delta P Exchanger Name



Pump Duty __75_kPa Copy of Reboiler



Tube Side Inlet



Steam In 2



Tube Side Outlet



Steam Out 2



Shell Side Inlet



Pump Out



Advanced Columns



Pump Name



5.
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Reboiler Pump



Shell Side Outlet



Reboiler Out



Heat Exchanger Model



Exchanger Design (Weighted)



Tube Side Pressure Drop



50 kPa



Shell Side Pressure Drop



75 kPa



Steam In 2 conditions



Saturated pure steam at 200°C. Mass flow 2500 kg/h.



Use a Set operation to specify the Reboiler Out stream temperature to be the same as the column bottom product stream.



Save your case!



Column Sizing HYSYS contains a Tray Sizing utility that greatly simplifies the mechanical design of a distillation column. A user can size full towers, or sections of towers, by specifying information related to the trays, tower internals, the downcomers, and the weirs. The most common use of the Tray Sizing utility is to identify a tray section, and then make HYSYS size the tower into sections based on your input, then if desired, perform a rating analysis on the column. While HYSYS is able to size and rate tray sections, the values that it provides are only rough estimates and should be treated as such.



Column Sizing in Design Mode 1.



Select Tools/Utilities from the Main Menu bar, or press the hot key CTRL U.
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2.



Select Tray Sizing from the list of available utilities and click the Add Utility button. Figure 5



3.



Click the Select TS... button, and select LPG Recovery as the Flowsheet and Main TS as the Object.



HYSYS allows users to select Tray Sections instead of entire columns so that users may size Side Strippers independently from the Main Column. 4.



Click the Add Section... button. Accept all of the default values that are presented.



HYSYS will calculate the dimensions of the column using preset values for the column internals and for the various parameters.
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On the Performance tab a summary of the calculations are presented. A brief explanation of the terms follows: • • • •



Number of Flow Paths. The number of times liquid crosses the tray, most trays are single-pass or have NFP of 1. Maximum Downcomer Backup. Represents the maximum amount of liquid hold-up in the downcomer that can be tolerated by the column before flooding occurs. Maximum Weir Loading. Measures the amount of liquid flowing over the weir. Pressure Drops. Estimates the total pressure drop over the section and the maximum pressure drop per tray.



What is the maximum pressure drop per tray in the Distillation Column?



Over which tray does this pressure drop occur?



What is the diameter of the trays inside the column?



What is the total section height?



Column Sizing in Rating Mode In rating mode, HYSYS allows you to perform rating calculations based on a specified tower diameter and fixed tray configuration.
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Exercise Head office is desperate to build a distillation column, but the fabrication mill is working overtime and there are very lengthy delays for special orders. The mill has the following trays in stock: Diameter, m (ft.)



NFP (Passes)



0.75 (2.5)



1



1.0 (3.3)



1



1.25 (4.1)



1



Obtain the flow parameters and pressure drops for a column that uses the trays as given above. The following requirements must be met in order for the column to be constructed. • • •



Maximum% Flood = 85 Maximum weir loading = 80 m3/h-m (860 ft3/h-ft) Maximum downcomer backup = 50%



For each case, follow these steps:
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1.



On the Design tab, click on the Specs page and set the Mode to Rating.



2.



Set the diameter and number of flow paths, and move to the Performance tab.



3.



Leave all the other specs at the default values.



Advanced Columns



4.
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Complete this table with the information provided by HYSYS.



Case Number



1



2



3



Diameter, m (ft.)



0.75 (2.5)



1.0 (3.3)



1.25 (4.1)



NFP



1



1



1



Weir Load Flood DC Back Up Total Delta P



Compare the table above with the specifications on the previous page; which set of trays will best meet the restrictions? Remember that smaller trays will be less expensive.



Save your case!



Challenge The Export Pressures button on the Tray Sizing Utility Performance tab allows the calculated pressure drops to be exported to the column pressure profile. Use this feature to supply the LPG Recovery Column with the rigorously calculated pressure profile. Hint: Currently the condenser, reboiler, top and bottom tray pressures appear as calculated (black) numbers. You will need to make them specified (blue) before the Export Pressures function will work.
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Sub-Flowsheets HYSYS has a multi-flowsheet architecture. This allows a large process to be split up into smaller sections or Sub-Flowsheets. Each SubFlowsheet, has its own streams and operations, PFD and workbook, and can be independently linked to a Fluid Package.



Templates A Template is a special sort of HYSYS case, which has been set up ready for easy insertion as a Sub Flowsheet into other HYSYS cases. Template files have the file extension *.tpl.



Workshop A typical use for templates is to construct a library of ready-made plant sections ready to be installed into other models. In this module a refrigeration loop template will be constructed and then installed into the Turbo Expander plant model.



Learning Objectives By completing this module, you will learn how to: • • • •
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Build a template and/or a sub-flowsheet Install a template into a case Move objects between Flowsheets Efficiently use templates and sub-flowsheets in your simulations
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Creating a Template There are three ways to create a template: • • •



Convert a whole flowsheet into a template Create a new template Convert part of a flowsheet into a template.



Convert a Whole Flowsheet into a Template 1.



Access the cases Main flowsheet's Property view (Simulation - Main Properties or press CTRL M) and select the Convert to Template button. You will be asked to confirm changing the case to a template, and whether you want to save the simulation (as an ordinary *.hsc case file) first before converting it to a template.



2.



Set the Template Tag, Transfer Basis (if a material stream) and other optional template information if required. These settings are covered later in this module.



3.



When you save the simulation, it will be saved as a template.



Create a New Template 1.



From the File menu, select New, then Template.



2.



Follow the standard procedure for building your simulation.



3.



Access the cases Main flowsheet's Property view (Simulation - Main Properties or CTRL M) and set the Template Tag, Transfer Basis (if a material stream) and other optional template information if required.



4.



When you save the simulation, it will be saved as a template.
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Convert Part of a Flowsheet into a Template There are two possible approaches. The easiest is as follows: 1.



On the PFD, select all unit ops and streams you wish to "capture".



2.



Right-click on any of the selected objects and select Cut/Paste Objects and then Copy Objects to File (Export). Save the group of objects to a *.hfl file.



3.



From the File menu, select Open, then Cut/Copy/Paste, then navigate to the *.hfl file you just saved.



4.



Convert the new case that is created to a Template as in the “Convert a Whole Flowsheet into a Template” section above.



Alternatively a group of objects can be copied and pasted into a new Template, using a combination of the two methods above. The disadvantage of this approach is that some fluid package assignments may need to be manually adjusted.



Example - Refrigeration Loop For this example, a refrigeration loop Process Template will be constructed. This template will then be installed as a sub-flowsheet into the Turbo Expander plant simulation built so far in this course. Don’t worry if you haven’t built the Turbo Expander plant case. The file “ADV1_GettingStarted_Soln .hsc” contains this case.
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The required power loads will be will then be determined and displayed on the main flowsheet.
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Build the following simulation as a new case. Use PR as the property package. Figure 1



2.



Initially set Chill-Q to 1E6 kJ/hr, make sure the case solves and looks acceptable.



3.



Ensure that the refrigerant flow rate is positive. If it is not, consider why this might be. Check your PFD carefully and make the appropriate changes.



4.



Save the case as Mixed Refrig.hsc.



Now the simulation needs to be converted to a template, by following the instructions above. However before you do this, you must make sure the template is "ready to run". If it is converted and saved as it is now, then when it is installed into a case, HYSYS will generate a consistency error. This is because there are no unknown variables in the Refrig unit, so when a chiller duty is set from the main flowsheet the model will be overspecified.To overcome this the specified Chill-Q value needs to be removed, thus leaving the loop unsolved. Now when the chiller duty is set by the main flowsheet the loop will solve correctly. 5.



Remove the Chiller duty, then convert the case to a template following the instructions given on page 4, use the name Mixed refrig.tpl.
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Template Properties The properties for the template can be set on the Main Properties window (Simulation - Main Properties or CTRL M). The first few tabs of this window are the same as for any simulation case. However, the two final tabs are exclusive to Templates. These are Exported Connections and Exported Variables. These two tabs only appear when the case has been converted into a template. Figure 2



The Exported Connections tab lists all the feed and product boundary streams in the flowsheet, and allows a Transfer Basis to be set, this will be used when the stream is linked between flowsheets. Connections and Transfer Basis are covered in more detail shortly. The Template Tag is used to identify the flowsheet within the case.
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The Installed Simulation Basis option controls what Fluid Package the flowsheet will use when it is imported into another case. • •



Internal - Use the Fluid Package it has now External - Use the Fluid Package of the parent flowsheet



Figure 3



Key variables within the flowsheet can be configured here and then easily monitored on the sub-flowsheet's property view when it is imported into the parent flowsheet. It is not necessary to make any changes on these two tabs, all settings can be configured later when the template is imported as a sub flowsheet into another case.
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Installing a Template in a Simulation 6. Flowsheet icon



Reactivate the flowsheet from the previous module. To install click on the Flowsheet icon on the object palette and select Read an Existing Template. Select the template you have just saved. Figure 4



Once the template is installed as a new sub-flowsheet any subsequent changes made only effect this instance, they do not effect the template from which the sub-flowsheet was derived.



Connections Tab On the Connections tab, you can enter all the Feed and Product connections between the sub-flowsheet and the main flowsheet. Feed connections are material or energy streams into the sub-flowsheet, products are out of the sub-flowsheet.



Internal streams refer to streams in the subflowsheet. External streams are in the main flowsheet.
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7.



Click on the External Stream box along side Chill-Q and select Q100 from the pull down menu.



8.



For the other two streams there are no existing streams in the main flowsheet so give them new stream names as in Figure 6.



9.



Rename the sub-flowsheet to Mixed Refrig Unit.
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Figure 5



Figure 6



You will notice the Chill-Q stream on the sub-flowsheet is automatically renamed Q-100 to match the main flowsheet stream name.
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Template Tag Tags are short names used to identify the sub-flowsheet associated with a stream or operation when viewed outside the sub-flowsheet. The default Tag name for sub-flowsheet operations is TPL1 (e.g.: strm6@ TPL1). When more than one sub-flowsheet operation is installed the default tag increases, TPL2, TPL3 etc. You may give sub-flowsheets proper names (e.g.: refrig1).



Exporting Sub-Flowsheet Variables 10. Use the Variables tab to export the following variables: • Condenser Duty, Heat Flow • Comp-HP, Power • Stream 1, Mass Flow 11. Edit the variable descriptions to show what the variables represent. Figure 7



Notice that the values of these variables are now displayed on the Parameters tab.
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Reviewing the Simulation Basis 12. Enter the Simulation Basis. Note that since the default Internal Basis option was used when configuring the template, the refrigeration loop sub-flowsheet is using a different fluid package to the main flowsheet. If required the fluid package used by each sub-flowsheet can be changed in the right table. Figure 8
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Transfer Basis HYSYS has the option to model a sub-flowsheet using a different fluid package to the main flowsheet. This allows, for example, the modelling of a Gas Sweetening process as a sub-flowsheet using PRSour within a main flowsheet using PR. As each fluid package could calculate different properties HYSYS must do a flash for any streams passing between flowsheets. The Transfer Basis sets what kind of flash is done. Flash Type



Description



P-H Flash



The Pressure and Enthalpy of the material stream are passed between flowsheets. A new temperature and vapour fraction will be calculated. Since the Enthalpy basis may be different for each property package this option is only recommended when the same fluid package is in use for both streams.



T-P Flash



The Pressure and Temperature of the Material stream are passed between flowsheets. A new Vapour Fraction will be calculated.



VF-T Flash



The Vapour Fraction and Temperature of the Material stream are passed between flowsheets. A new Pressure will be calculated.



VF-P Flash



The Vapour Fraction and Pressure of the material stream are passed between flowsheets. A new temperature will be calculated.



None Required



No calculation is required for an Energy stream. The heat flow will simply be passed between flowsheets.



In this case no transfer basis is required since only energy streams pass across the flowsheet boundary.
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Finish this section 13. Tidy up the PFD, and add a PFD table for the sub flowsheet to show the exported variables. (PFD tables are added by right clicking on the object and choosing Show Table.). Figure 9



Save your case! Challenge In this case the chiller is simulated using a cooler in the main flowsheet linked with an energy stream to a heater in the sub-flowsheet. It is possible to replace the heater and cooler with a single heat exchanger. One of the features of the HYSYS heat exchanger is the option to have the streams on each side of the exchanger in different flowsheets. Replace the heater and cooler with a single heat exchanger in the main flowsheet. What advantages does modelling the chiller in this way have? If you try this challenge, make sure to save your case with a different file name and revert back to the separate heater and cooler case for subsequent modules.
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Creating and Manipulating Sub-flowsheets Sub-flowsheets can be created without first creating a template by choosing one of the other two options when adding a flowsheet. Figure 10



The paste exported objects buttons allows a sub flowsheet to be created that contains a group of objects that have previously been saved as a *.hfl file (by using the PFD right click Cut/Copy Objects … Copy Objects to File function). A sub-flowsheet can also be created to contain a group of objects that already exist on the main flowsheet. 1.



On the Turbo Expander plant PFD, select Cooler E-101 and compressor K-102, their energy streams, and stream 13. Figure 11



2.
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Right-click on any of these objects and select Cut/Paste Objects and then Combine Into Sub-Flowsheet.
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This group of objects are then combined into a sub-flowsheet. HYSYS automatically sets up all the stream connections Figure 12



3.



Right-click on the sub-flowsheet icon and choose Cut/Paste Objects then Move Contents To Owner Flowsheet. Figure 13



HYSYS returns everything back to the main flowsheet level. 4.



Select the sub-flowsheet icon and delete it as it is now empty.



Viewing and Editing the Sub-Flowsheet Pressing the Sub-Flowsheet Environment button on the sub-flowsheet operation window causes HYSYS to enter the sub-flowsheet environment. (This is equivalent to pressing the Column Environment
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button on the column to enter the column sub-flowsheet environment.) Figure 14



The Environment label at the top right corner of the HYSYS window indicates which environment is currently active. To return to the main flowsheet, press the Enter Parent Environment button. Whilst in the sub-flowsheet environment, the HYSYS solver will only solve the streams/operations within the sub-flowsheet. To see the effect of any changes on the whole case it is necessary to return to the toplevel flowsheet. It is also possible to open the sub-flowsheet PFD and make changes whilst remaining in the main flowsheet environment. Hence any changes made in the sub-flowsheet immediately affect the whole case. To open the PFD for the sub-flowsheet: 1.



Right-click on the PFD icon of the sub-flowsheet.



2.



Choose Open PFD. Alternatively use the Tools-PFDs menu.



In HYSYS versions prior to 3.1, it was necessary to enter the subflowsheet environment to make any topology changes to the subflowsheet (e.g., change stream connections, add/delete objects, etc.), however this restriction has now been removed.
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Use of Templates and Sub-Flowsheets Consider the following possibilities: • • • • • •



A case can contain multiple layers of sub-flowsheets Your company could develop a library of templates for everyone to access. These become company standards, and can be more easily maintained and approved Using library templates saves time in modelling and improves QA Complicated simulations are much easier to handle if split into sub-flowsheets Large PFDs are easier to read if you use sub-flowsheets Several engineers can work on the same overall simulation by using templates



Note that links are not dynamic. If a template is modified, it needs to be reloaded into the simulation case for the changes to be incorporated.
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Spreadsheets and Case Studies



Workshop The HYSYS Spreadsheet is a powerful tool that allows the user to apply Spreadsheet functionality to flowsheet modelling. The Spreadsheet has complete access to all process variables; this allows the Spreadsheet to be virtually unlimited in its applicability and function. In this module, the Spreadsheet will be used to calculate a simplified profit for the operating plant.



Learning Objectives After completion of this module, you will be able to: • • • •
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Import and export variables to and from the Spreadsheet Add complex formulas to the Spreadsheet Use the HYSYS Spreadsheet in a wide variety of applications Use the casestudy utility to evaluate your flowsheets
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The HYSYS Spreadsheet With complete access to all process variables, the Spreadsheet is a very powerful tool in the HYSYS environment. The power of the Spreadsheet can be fully realized by the addition of formulas, functions, logical operators, and basic programming statements. The Spreadsheet's ability to import and export variables means that seamless transfer of data between the Simulation Environment and the Spreadsheet is a simple matter. Any changes in the Simulation Environment are immediately reflected in the Spreadsheet, and viceversa. The Spreadsheet has several common applications. For example, the Spreadsheet can be used to: • • •



Collect together key inputs and results between flowsheet objects. Relate the pressure drop in a Heat Exchanger to the flow. Perform mathematical operations using variables from the simulation.



Importing and Exporting Variables Note that it is not possible to import into, and export from the same cell, instead use two cells one for the import and one for the export, and link them together with a simple '=A1' type formula.



Any variable in the case can be imported into the Spreadsheet. The contents of any Spreadsheet cell can be exported to any specifiable (blue) variable in the case. There are three ways of importing values into the Spreadsheet. •



•



Drag and Drop. Position the cursor over the desired item; then click and hold the right mouse button. Move the cursor over to the Spreadsheet. Once over the Spreadsheet, the cursor's appearance will change to a "bull's eye" type. Release the right mouse button when the "bull's eye" cursor is over the desired cell. The specific information about the imported variable will appear in the Current Cell group. Variable Browsing. A variable may also be imported into the Spreadsheet by placing the cursor on an empty cell in the Spreadsheet and clicking (and releasing) the right mouse button. Choose Import Variable from the list that appears, and select the variable using the Variable Navigator.
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•



Connections Page. On the Connections page, click the Add Import button and select the desired variable using the Variable Navigator. After selecting the variable, choose the desired cell from the drop-down list.



Exporting variables from the Spreadsheet into the Simulation environment is also a simple procedure. The methods for doing this are very similar. The value in any spreadsheet cell can be exported, except if it is an imported value.



•



•



•
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Drag and Drop. Position the cursor over the Spreadsheet cell that is to be exported. Click and hold the right mouse button; the cursor should now change to the "bulls' eye" type. Move the "bull's eye" cursor over to the desired cell. Release the right mouse button, the transfer should be completed. Variable Browsing. A variable may be exported from the Spreadsheet into the Simulation environment by placing the cursor on the exportable cell in the Spreadsheet and clicking (and releasing) the right mouse button. Choose Export Formula Result from the list that appears, and select the desired location for the variable using the Variable Navigator. Connections Page. On the Connections page, click the Add Export button and select the desired variable using the Variable Navigator. After selecting the variable, choose the desired cell from the drop down list.
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Building the Spreadsheet Don’t worry if you haven’t built the Turbo Expander plant case. Use the file ADV4_Templates_Soln.hsc.



In this module a Spreadsheet to calculate a simple profit margin will be added to the Turbo Expander plant. 1.



Add a Spreadsheet to your model by double-clicking on the Spreadsheet icon on the Object Palette. Rename the spreadsheet Profit Analysis.



2.



On the Spreadsheet tab add the following text labels. Figure 1



3.



Set up the required imports. Figure 2



Try each of the methods described on page 3.
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4.



Set the Cost of Power (cell D1) to be 0.05 $/kWh and the LPG value to be 0.2 $/kg.



5.



Enter the formulae below.



In this Cell...



Enter...



B6



=B4+B5



D6



=D1*B6



D8



=D2*B8



D9



=D8-D6



Notice that HYSYS assigns variable types of Heat flow to cell D6 and Mass flow to cell D8. This is because these are the variable types of the cells involved in the calculation. 6.



Using the Variable Type drop-down list above the spreadsheet, change the types of these cells to unitless.



The spreadsheet should now look like this: Figure 3



Remember in HYSYS process variables appear as blue numbers, calculated ones as black, and in spreadsheets any calculated numbers are shown in red.
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The only cell remaining to be completed is B9. This is going to be used to control the temperature of the refrigerant in the Mixed Refrig Unit. 7.



Add a formula in cell B9 such that it is 5°C cooler than the Chiller exit temperature



Spreadsheets and Case Studies



To delete the temperature there is no need to enter the Refrigeration sub-flowsheet environment, simply right click the sub-flowsheet icon and press 'Open PFD’



8.



In the Mixed Refrig Unit sub-flowsheet, delete the temperature in stream 3.



9.



Export the temperature from B9 to stream 3.
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In order to make it easier to access and use the spreadsheet cells in another unit op (e.g. an Adjust) or in the Databook, cells can be named. This is done either by selecting the cell on the Spreadsheet tab and typing a name in the Variable field above the spreadsheet, or on the Parameters tab. 10. Name cells D6, D8, and D9 as in the following figure. Figure 4



With a process temp of -62°C and a turbo exit pressure of 28 bar we have a profit of $493.8 /h. Change the chiller exit temp to -60°C and the expander exit pressure to 20 bar. What is your new profit?



Save your case! 7
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Use of Spreadsheets The spreadsheet can be a very useful tool in HYSYS to: • • • • •



Pull together important parameters in the simulation into a single unit op. Use it to try "what ifs" by changing process variables and seeing if your target variables change, and in the right direction. Perform additional calculations that are not possible in HYSYS directly, such as the profit calculation you have just done. Combine data from process streams, energy streams or utility streams and use multiple spreadsheets to calculate your total cooling water requirements or power requirements. Careful use of spreadsheets can save you having to open several windows in HYSYS in order to both input information, or examine results. You can see that a spreadsheet can be used to set various parameters in the flowsheet as a result of a calculation on another variable. So in the flowsheet here the three sets controlling the pressures of streams 8, 9 and 10 could be replaced with a spreadsheet doing the same thing.



Note that when copying and pasting, spreadsheets links are not always maintained. To ensure all links are maintained convert the relevant part of the case to a template.



Challenge As you can see the simulation can be "driven" from the spreadsheet, by changing the temperature of stream 2 and the pressure of stream 5 and looking at the new profit. Do you think you could use the spreadsheet to optimise the cooler exit temperature and turbo expander exit pressure to give the maximum profit available? You could but it would take a long time using trial and error.
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The Case Study The Case Study tool allows repeated runs with varying input parameters to be automated. In the next section you will set up a case study to vary the Cooler exit temperature and Expander exit pressure between defined limits. For each case various results are recorded for analysis later. 1.



Open the DataBook from Tools-Databook, or by pressing CTRL D.



With the DataBook, HYSYS provides a location from which a systematic approach to data analysis can be taken. The DataBook allows you to monitor key process variables in Steady State and in Dynamics mode. Variables for all DataBook features are selected in a single location. You can then activate variables from the main list for each application. There is only one DataBook in each HYSYS case, containing variables from all Flowsheets. All of the following features are defined and accessed through this single DataBook: Figure 5
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The first step is to configure all the variables of interest, both variables to be varied in the Case Study and the results. HYSYS will do a series of simulation runs and record the results for each case. If you omit a variable from the list you will not be able to look at it once the runs are complete. All data except for that declared is lost. Consider what you might want to observe before you commit to running the Case Study. 2.



Click on Insert and add the first variable as shown: Figure 6



Note that the variable descriptions shown for spreadsheet cells correspond to the Visible Name of each of the cells. Since these are blue parameters they can be edited here. Removing the cell reference will tidy up the Case Study and make the final graphs look more presentable. It is best to add all of the required variables in one go using Add, press OK, and then return and edit their descriptions, rather than adding and editing each in turn.
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Repeat the above until you have added the following variables. Remember to add all the variables first and then edit their descriptions. Figure 7



Note, at any time before you actually run the case study you may add or delete variables from this list. 4.



The Independent and Dependent variable checkboxes are only enabled when you add a case study. It is not necessary for all the variables to be ticked for each case study, a minimum of one dependent and one independent variable is required.



Go to the Case Study tab and click on Add to set up a new case study. Call it Operating Analysis.



All the previously configured variables are listed along with two columns Ind and Dep· • •



Independent variables are the ones that will be varied by the case study. These must be specified variables (i.e. blue numbers). Dependent variables are the results to be monitored.
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5.



Select the independent and dependent variables. Figure 8



{ }



Here you can Add, or Delete case studies, or view the variables set up for the highlighted case study.



6.



Here you check the Independent variables that are to be used in this Case Study and the Dependant variables you want to monitor.



Press View and configure the bounds as shown below. (Note the Pressure and Temperature units here are kPa and °C.) Figure 9



Five different temperatures with five different pressures, means a total of 25 states in all. For each of the states in the case study the whole case is solved, including any utilities. Since in this case the results from the tray sizing utilities are not needed in the case study, it makes sense to ignore the tray sizing utilities to speed up the case study.
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7.



Press CTRL U to open the list of Utilities and then view each tray sizing utility in turn and set it to Ignore.



8.



Click Start to set the study running. The Failed States tab will show any combination of independent parameters that fail to solve. While the case study is running, or when it has finished, you can review the results.



9.



Either press the Results button on the Case Studies Setup window or on the Case Studies tab of the Databook.
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Figure 10



The results can also be displayed graphically: 10. Select Graph on the Case Studies tab. 11. Select Setup.
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12. Click the Display Properties tab. Figure 11



The graph displayed will be the first variable that is checked in the list here, in this case LPG Sales. Change the selected variable to see other graphs.



13. Size and arrange the windows so that you switch the graph between the three dependent variables. Figure 12
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Figure 13



The main interest of course is the Overall Profit and the combination of Chiller exit temp and Expander exit pressure that will give us the maximum Operating Profit. Figure 14



14. Right-click on the graph, and experiment with the tools available. Try removing Hidden Lines, Rotation, and Plane Cutting. 15. In order to view the graph with the colours shown previously, rightclick on the graph and select Colour Control. Set the ranges as above. Note that the red colour appears because there is a discontinuity in the entered ranges between 410 and 430.
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Save your case! What can you see about the peak area of the operating surface? How many areas give you more than $470 / hr profit (Turquoise). Are they the same operational conditions?



What could this lead you on to study further?



Your tutor will go through this with you.



16. Before you leave this module, reset the chiller exit temperature to -62 ºC and the Turbo expander exit pressure to 28 bar. This will allow the next module to perform correctly.
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Introduction This module will introduce you to several advanced topics concerning the operation and convergence of the Recycle unit operation. The HYSYS Recycle logical operation is used to solve looped systems where downstream material is mixed back in upstream in the process. The Recycle is a logical operation; it does not transform the stream that passes through it. The Recycle operation can be used several times in a given simulation. Every time a recycle operation is added, the total time needed for the simulation to successfully calculate and converge increases. The information presented in this module can be used to reduce this time and achieve greater success with the Recycle unit operation.



Workshop The export gas compression section of the Turbo Expander plant is to be modified to deal with an additional hydrocarbon stream from elsewhere in the process. To cope with this additional load it has been decided to replace the existing single export gas compressor with a two-stage compression system. Each compressor is to be equipped with an after cooler and knock out drum. Liquids from each separator are to be recycled back to the previous stage.
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Learning Objectives In this module, you will learn how to: • • • • •



Build simulations using Recycles. Position Recycle operations for optimum performance. Use the various numerical parameters to help reduce convergence time. Consider interactions between Adjusts and Recycles and how to control them with Calc Levels. Use Simultaneous mode when the flowsheet contains multiple, interacting Adjusts.



Prerequisites Before beginning this module, you should have a reasonable understanding of the HYSYS program, and be able to add streams and operations, including the Set and Spreadsheet operations.



Structure of this Module This module is split into four main sections: • • • •



An information section discussing use and positioning of Recycle operations. The key points from this section are summarised on page 14. A series of exercises on Recycle positioning. A workshop where a new plant section that requires the use of Recycles is added to the Turbo Expander plant model. An exercise to illustrate the use of Simultaneous Adjusts.
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Recycle Operation Information Using the Recycle Unit Operation Recycle icon



The HYSYS Recycle logical operation is used to solve looped systems where downstream material is mixed back in upstream in the process. HYSYS employs a non-sequential solving method, which allows information to be propagated both upstream and downstream. This allows some looped systems to be solved explicitly (particularly heat recycles, and refrigeration loops). However for material recycles when downstream material is mixed back in upstream, a Recycle operation is needed.



Recycles are sometimes also know as ‘Tears’.



Forward and backward information transfer is discussed later in this module.



The Recycle operation allows HYSYS to solve looped system iteratively. A set of conditions are assumed and used to solve the recycle loop. The assumed values are compared with the calculated values and updated. This is repeated until the values match within a specified tolerance. The Recycle operation now allows information to be transferred both forwards and backwards (i.e. the assumed value to be in either the outlet or inlet stream), although usually information is only transferred forwards (i.e. assumed value in outlet). When the Recycle operation is first added, initial estimates need to be provided for all the assumed values. Typically this is done by allowing HYSYS to solve before closing the recycle loop. This is illustrated in the Workshop.



The Recycle Unit Operation and Dynamic Simulations The Recycle operation has a role only in Steady State simulations. While operating in Dynamics, it is perfectly acceptable to return a product stream to an upstream operation without using a Recycle operation. If a Recycle operation is used, it will be ignored while operating in the Dynamic mode; the inlet and outlet streams will always be equal.
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Positioning the Recycle Operations for Optimum Performance It is possible to have numerous Recycle operations in a single simulation. When several Recycle operations are used together, the total calculation time can be reduced by carefully selecting the location of the Recycle blocks. When a user is deciding on a tear (Recycle) location, the first choice is often in the actual recycling stream. This is an acceptable choice if only one Recycle operation is being used. If more than one block is being used, however, a better location may reduce the calculation time needed to solve the simulation. Try to locate recycles: • • • •



To define multiple streams (i.e. before Tees, after Mixers). See Exercise 2. In streams with fixed conditions (e.g. cooler and heater outlets). This means fewer variables need to be iterated on. To avoid conflicts with Adjust operations. This is illustrated later in the Workshop. In major flow streams. These are likely to be more stable.
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Setting the Recycle Tolerances After the Recycle operation has solved the inlet and outlet streams will match each other within certain tolerances. HYSYS allows the user to set these tolerances to match the requirements of their simulation. The actual tolerance of the Recycle operation is calculated as the product of the absolute tolerance for the given property (fixed within HYSYS) and the relative tolerance (specified by the user). The absolute tolerance is dependant on the specific property in question, and is set by the HYSYS program. The following table gives the absolute tolerances for each property. Property



The Internal Vapour Fraction tolerance, when multiplied by the default recycle tolerance, is 0.1, which appears to be very loose. However, in most situations, if the other recycle variables have converged, the vapour fraction in the two streams will be identical. The loose Vapour Fraction tolerance is critical for close-boiling mixtures, which can vary widely in vapour fraction with minimal difference in other properties.



Absolute Tolerance



Internal Unit



Vapour Fraction



0.01



Temperature



0.01



Pressure



0.01



kPa



Flow



0.001 (this is a relative error)



kgmole/s



Enthalpy



1



kJ/kgmole



Composition



0.0001



°C



Ticking the Use Component Sensitivities checkbox allows different tolerances to be used for each component.



While the absolute tolerances are set within the program, the user specifies the relative tolerances. The default relative tolerance for all properties is 10, which HYSYS inserts automatically. You are able to specify any value here; remember, however, that smaller tolerances will require more calculation time. When connected to energy streams, the Recycle operation uses an absolute internal tolerance of 0.1 kW. (kW is the HYSYS internal unit for energy). The tolerance sensitivity multiplier used is Enthalpy.
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Figure 1



Tolerances are calculated using HYSYS internal units - These units are essentially the SI System with pressures in kPa (as shown in the table above). But how does HYSYS calculate the actual tolerance of the Recycle operation? To answer this question, take the example of Temperature. Multiplying the default relative tolerance of 10 by the set absolute tolerance of 0.01 gives a tolerance of 0.1. This means that the temperature of the Recycle's outlet stream must be within 0.1°C (0.18°F) of the temperature of the Recycle's inlet stream in order for the operation to be solved. For flow rate the tolerance quoted in the table is relative. The absolute tolerance is calculated by multiplying the flow rate in internal units (kgmole/s) by the factor 0.001. For example with a flow rate of 100 kgmole/s and the standard multiplier of 10 the actual tolerance is calculated as follows: Actual Tolerance = Relative Tolerance x Absolute Tolerance = Relative Tolerance x 0.001 x Flow rate in kgmole/s = 10 x 0.001 x 100 = 1 kgmole/s



Hence, the flow will be solved if it is within 99 - 101 kgmole/s.
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If your simulation contains streams with very low (ppm) concentrations, you may want to set the concentration tolerance to a lower value. Otherwise the default tolerances work well in most applications.



Other Variable Parameters The Transfer Direction column allows you to select the transfer direction of the variable. There are three selections: • • •



Not transferred Transfer forwards Transfer backwards



The Not Transferred option can be used if you only want to transfer certain stream variables. For example, if you only want to transfer P, T, composition and flow, the other variables could be set to Not Transferred. When the checkbox is deactivated, the Recycle operation waits until the inlet stream is completely solved before performing the next calculation step. The default setting for the checkbox is inactive.



Using the Acceleration Parameters The Recycle operation can be set to use one of two types of mathematical algorithm in order to reach a converged solution faster. The two available acceleration methods are: • •
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Wegstein Acceleration Dominant Eigenvalue Acceleration
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Figure 2



Using the Wegstein Acceleration There are several numerical parameters that define the operation of the Wegstein Acceleration. These parameters will be defined here: Parameter



Default Value



Definition



Acceleration Frequency



3



The number of iterations per number of accelerations. Using the default, acceleration is applied to every third iteration.



Qmax



0



Sets the maximum value for Q in Wegstein equation.



Qmin



-20



Sets the minimum value for Q in Wegstein equation.



Acceleration Delay



2



The number of iterations before the first acceleration is applied.
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The Wegstein equation is given here. This equation is used to determine the values passed to the outlet stream for each accelerated iteration. XN + 1 = Q × XN + ( 1 – Q ) × Y N where:



(1)



X = the value in the outlet stream (assumed) Y = the value in the inlet stream (calculated) N = the iteration number Q = the acceleration factor



HYSYS chooses the value of Q that it will use depending on the amount of change that has occurred between successive iterations. A larger value of Q will be used when the change between successive iterations is large, and vice-versa.



Adjusting the Wegstein Acceleration



A positive Q will help dampen out any oscillations that may occur. The Qmax should be increased if, and only if, oscillations are affecting the convergence of the Recycle.



While Wegstein acceleration has been shown to reduce the number of iterations needed to converge a Recycle operation in most cases, there are a few cases in which the default Wegstein parameters will not help to converge the Recycle operation. In these cases it is necessary to reduce the amount of acceleration, or to ignore it all together. Setting the Qmin value to a smaller negative number will reduce the amount of acceleration. The acceleration can be ignored completely by the Recycle operation if the Acceleration delay is set to a high enough value. Typically, Recycle operations will converge in less than 10 steps; therefore, setting the Acceleration delay to a value much larger than 10 means that acceleration will not occur. Very rarely, the Recycle operation will oscillate as it converges on a solution. If you find this happening in your simulation, you can increase the value of Qmax to a small positive value. This will provide a damping effect that will, hopefully, reduce the oscillating behaviour.
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Using Successive Substitution In the rare cases in which Wegstein acceleration will not help to reduce the number of iterations in the Recycle operation, it may be necessary to set the operation to use Successive Substitution in order to reach convergence. Successive substitution is when the recycle's outlet stream properties are rewritten with the inlet stream properties without any type of acceleration applied. This is considered the most stable solving method; however, it is also the slowest. This can be accomplished using one of two methods; either set the Acceleration Delay term to a large value, e.g.100, or set both Qmax and Qmin to 0.



Using the Dominant Eigenvalue Acceleration Method The Dominant Eigenvalue Acceleration method is less adjustable than the Wegstein method. It is recommended for Recycle operations in systems that are non-ideal and/or where strong interactions exist between the components. This method has the advantage of examining the interactions between the variables during the acceleration process.



Information on Multiple Recycles When installing multiple Recycle operations, you have the choice between Nested or Simultaneous solution. They should be used as follows: •



Nested - Single Recycle or multiple, non-connected recycles
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•



Simultaneous - Interconnected, interacting recycles



In the Simultaneous example, the number of recycle operations may be reduced to one if placed in the correct stream.



When Recycle operations are selected as Simultaneous, they will not be calculated with the other unit operations. Instead, they are listed in a separate solver, and calculated only after the ordinary solver has finished calculating all other unit operations in the flowsheet.



Some Troubleshooting Tips Typically, Recycle operations will converge in less than 10 steps. However, if the tolerances have been reduced, or the system is nonideal, it may take more than the 10 iterations that HYSYS has set as the default limit. Once the limit has been reached, HYSYS will stop and ask the user if it should leave the operation unconverged, or continue for 10 more iterations. If your Recycle operation has not converged in 10 iterations, it may be advantageous to stop the calculations and examine the flowsheet.



Monitoring the Recycle‘s Calculations The progress of the calculations performed by the Recycle operation can be checked on the Monitor page of the operation's property view. This is useful if the Recycle is having problems converging. The results can be seen in tabular format, or in a plot format.
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Choosing a Flash Type It is possible to choose the type of flash that the Recycle operation will perform. The default choice is a PT flash. A PT flash means that pressure (P), temperature (T), and composition values are passed through the Recycle operation, and other variables (vapour fraction (V), enthalpy (H), and entropy (S)) are calculated in the other stream. Composition and Flow rate values are always passed through the Recycle operation, regardless of the flash type.



Choices of flash type include PH, PV, PS, and TV. While a PT flash will be sufficient for most applications, a PH flash is a better choice for very pure recycle streams. When dealing with very pure streams, a small change in T can make a big difference in H. Take a pure water stream at atmospheric pressure, for example, the enthalpy (H) of that stream will be very different if the temperature is 99.9°C (211.9°F) or 100.1°C (212.1°F).
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Information Summary Using the Recycle Operation • •



The Recycle operation is used to solve looped systems where downstream material is mixed back in upstream. Initial estimates are needed for all assumed values.



Recycle Tolerances • • •



Calculated as the product of the relative tolerance (user specified) and the absolute tolerance (set in the program). Tolerances are calculated using HYSYS internal units. Recycle streams that have very low concentrations of important components, may require lower relative tolerances for the composition specification.



Using the Acceleration Parameters •



•



There are two types of acceleration available: Wegstein and Dominant Eigenvalue. Wegstein is the most common, and Dominant Eigenvalue is recommended for simulations where strong interactions exist between the components. Wegstein acceleration can be controlled using the four factors available: Acceleration Frequency, Qmin, Qmax, and Acceleration Delay.



Multiple Recycles When using Multiple Recycles set the Calculation mode as follows: • •



Nested - Single Recycle or multiple, non-connected recycles Simultaneous- Interconnected, interacting recycles



Flash Types • • • 14



The flash type can be changed. Use default PT flash choice for most cases PH flash is better for very pure recycle streams.
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Recycle Positioning Exercises Exercise 1 Examine the following PFD. This Flowsheet has three physical recycles and three HYSYS recycle operations. What is the minimum number of recycle operations that are needed? _____________________________________________________________ Where should the recycle operation(s) be positioned?____________ Figure 3 - Exercise 1
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Exercise 2: Adding a Recycle Assume the condenser outlet stream is fully defined (except flow rate), the chiller duty and outlet conditions are known, the pressure drops across the condenser and chiller are known, and the stage 1 compressor outlet pressure is known. How many recycles are needed in this flowsheet, where should they be placed, and why?



____________________________________________________________ Figure 4 - Exercise 2
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Exercise 3 Assume that the Feed is fully defined, Shell and Tube Side pressure drops are known, as well as the Column Feed temperature. How many recycles are needed in this flowsheet, where should they be placed, and why?



_____________________________________________________________ Figure 5 - Exercise 3
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Exercise 4 Assume the Feed is completely defined, shell and tube side pressure drops for E-100 and E-101, and the temperatures of streams 3 and 4 are known. How many recycles are needed in this flowsheet, where should they be placed, and why?



____________________________________________________________



Figure 6 - Exercise 4
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Exercise 5 Assume the Feed is completely defined, and the shell and tube side pressure drop for E-100 are known. How many recycles are needed in this flowsheet, where should they be placed, and why?



____________________________________________________________



Figure 7 - Exercise 5
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Exercise 6 Examine the three stage compression plant PFD on the next page. This flowsheet has five physical recycles and six HYSYS recycle operations. What is the minimum number of recycle operations that are needed? _____________________________________________________________ To answer this question consider all the information about recycle positioning in this module, and note the following: • • •



Every Exchanger in the PFD has pressure drops defined E103 has a UA specified E104 has an outlet temperature specified



Where should the recycle operation(s) be positioned?______________
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Figure 8 - Exercise 6
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Workshop Building the Simulation This module will continue with the case built in the Getting Started module. This is a Turbo Expander plant with an export gas compressor.



Don’t worry if you haven’t built the Turbo Expander plant case. The file “ADVI_GettingStarted_Soln. hsc” contains this case.



In this workshop the existing compressor will be replaced with a twostage compression system. Each compressor is to be equipped with an after cooler and knock out drum. Liquids from each separator are to be recycled back to the previous stage. The reason for this modification to the plant is that an additional hydrocarbon stream must be processed. To simplify the main PFD the two stage export gas compression system will be constructed in a new sub flowsheet.
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Process Overview Figure 9
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Add the New Feed Stream Add the Feed HC stream with the following conditions and composition to the main flowsheet. Name



Feed HC



Temperature



35°C (95°F)



Pressure



3000 kPa (435.1 psia)



Flow rate



6000 kgmole/hr (13228 lbmole/hr)



Component



Feed Stream



Nitrogen



0.005



CO2



0.015



Methane



0.32



Ethane



0.24



Propane



0.11



i-Butane



0.075



n-Butane



0.075



i-Pentane



0.065



n-Pentane



0.05



n-Hexane



0.045



Add a New Sub-Flowsheet Object Palette Sub Flowsheet button



Add a new sub flowsheet and choose to Start with a Blank Flowsheet.



Make Feed Connections The Allow Multiple Stream Connections option allows any stream to be connected anywhere. Without it you can only make a feed connection for a stream that is not already connected as a feed stream elsewhere.
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Rather than delete the existing export gas compressor, the new system will be connected in parallel on the HYSYS PFD to allow for comparison (i.e., the full export gas flow rate will go through both export gas compression options). In order to allow this the "Multiple Stream Connections" feature of HYSYS must be enabled.
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1.



Go to the Session Preferences window (via the Tools-Preferences menu).



2.



Tick the Allow Multiple Stream Connections option on the Simulation page in the Options tab.
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Now stream 13 can be connected to the Sub flowsheet even though it is still the feed stream to the existing export gas compressor. 3.



In the Sub-flowsheet operation window on the Connections tab, connect up streams 13 and Feed HC as feed streams to the subflowsheet by using the dropdown menu under external stream.



4.



Review the Transfer Basis settings, here the default PH flash basis will be used.



5.



Change the Name of the sub-flowsheet to Export Gas Compression.



Build the Flowsheet Without the Recycle Operations You can find some of the required stream and operation names by referring to the PFD in the Process overview. If a stream name is changed in the sub-flowsheet, the name of the linked stream in the main PFD is not changed.



1.



Ensure you are in the sub-flowsheet environment.



2.



Rename stream 13 to the more meaningful From Main Case.



3.



Mix the two feed streams. Name the outlet Mixed Feeds.
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When mixing streams at different pressures the HYSYS Mixer operation offers a number of pressure assignment options. These can be found on the Parameters page of the Design tab. Figure 10



The Equalize All options will set the pressure of any connected streams so they are all equal.



4.



Ensure the Automatic Pressure Assignment option for the Feed Mixer is set to Set Outlet to Lowest Inlet.



Now the product stream from this first mixer is always at the lowest pressure of either of the two feed streams. 5.



Add another mixer ready to take the returned liquid from the first compression stage. The Mixer will have two feeds: Mixed feeds and one from the recycle. For now, just set Mixed Feeds as the inlet. Call the output To LP Sep.



The mixed feed streams are then fed to a separator, compressor, and after cooler.



Since HYSYS knows the Cooler outlet pressure and pressure drop, it can back calculate the Compressor outlet pressure.
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6.



Install a separator. Call it LP Sep. The vapour stream is named LP Sep Vap and the liquid stream is named LP Sep Liq.



7.



Install a compressor and a cooler. Use the following parameters:



Compressor Inlet



LP Sep Vap



Outlet



Stage 1 Out



Energy



Stage 1 KQ
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Cooler Inlet



Stage 1 Out



Outlet



E-Stage 1 Out



Pressure Drop



25 kPa



Energy



Stage 1 Eq



Set the temperature of stream E-Stage 1 Out to 30°C and the pressure to 5000 kPa. 8.



Install another mixer in preparation to take the second stage returned liquid. At the moment this will only have the first stage after cooler product as its feed stream. Call this mixer MP Mix and its product To MP Sep.



The second compression stage is an exact copy of the first. Hence here is a good place to make use of HYSYS' Copy / Paste functionality. 9.



Select the entire first compression stage from the LP Separator, to the after cooler product stream (EStage 1 Out).



10. Right click somewhere on the PFD and choose Cut/Paste Objects …. Copy Selected Objects from the pop up menu that appears.



Since the objects are being pasted immediately to the same flowsheet, the Clone function could have been used. This is equivalent to Copying then Pasting.



A question box may pop up if you did not also select all the attached streams for any of the operations you selected. 11. Unselect the objects, then right click on the PFD background and choose Paste Objects from the fly out menu. 12. HYSYS automatically renames the pasted objects so the stream names will need to be changed. Rename streams according to the flowsheet on page 20. 13. Install a final knock out drum and the product gas stream. 14. Modify the second compression stage so that the product gas will be at 70 bar. The liquid from the MP and HP Sep knock out drums is to be returned upstream, and hence must be flashed to the appropriate pressure. Since this may be altered in the design process it is sensible to link the returning liquid pressures to the compressor inlet pressures.



Object Palette Set icon



15. Install valves and valve outlet streams on the MP and HP Separator liquid products. Use a Set operation to make the valve outlet pressure the same as the appropriate compressor inlet pressure.
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Think carefully about the source streams for these pressures. Ensure the source stream is upstream of any operations effected by the returning flashed liquid.



Save your case! Installing the Recycles The PFD is now ready to add recycle operations. Initially Recycles will be added in the physical recycle streams. The physical recycle is often a convenient place to put the Recycle operation initially. Although it is not always the best place!



16. Install a Recycle on the outlet of the let down valve from the MP separator. 17. Add an outlet stream. In this case (as in the majority of all situations) the default parameters are appropriate. 18. Review the settings on the Parameters tab. 19. Connect the recycle outlet into the RCY-1 Mixer.



Object Palette Recycle icon



The first recycle will then iterate to a solution. 20. Repeat this procedure for the second liquid return.



Save your case!
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Analysing the Results Examine the convergence process for the Recycles. 21. Open the Recycle property view and look at the Tables page of the Monitor tab. How many iterations did each Recycle need to converge? _________________



22. Look at the Worksheet tab for each Recycle. Complete the following table: Recycle



RCY-1



RCY-2



Inlet VF Outlet VF Notice that the pressures are exactly the same on both sides of each recycle. Since these are specified by the set, there is no need to for HYSYS to iterate.



Inlet Temperature Outlet Temperature Inlet Pressure



3000 kPa (435.1 psia)



5000 kPa (725.2 psia)



Outlet Pressure



3000 kPa (435.1 psia)



5000 kPa (725.2 psia)



Inlet Molar Flow Outlet Molar Flow Inlet Molar Enthalpy Outlet Molar Enthalpy



Do any of the tolerances need to be tightened?



23. Make any tolerance adjustments you feel are necessary.



Make the Product Stream Appear on the Main Flowsheet Return to the main flowsheet and connect up an External stream for the product HP gas stream.



Save your case! 29
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Exercise Part of the design process for this new multi-stage compression plant is to choose an inter-stage pressure to balance the load between the two compressors. The details of setting up the spreadsheet are not covered here. If you have any problems with this section, ask the instructor.



In this exercise you will calculate the duty ratio for the two compressors using a HYSYS Spreadsheet, and then use an Adjust to change the interstage pressure such that the load is balanced across the two compressors. Add a Spreadsheet that calculates the Compressor Duty ratio. Figure 11
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Adding the Adjust Adjust button



The Adjust operation is another Logical Operation. It will vary the value of one stream variable (the Adjusted variable) to meet a required value or specification (the Target variable) in another stream or operation. 24. Add an Adjust operation. 25. For the moment check the Ignored box to prevent the Adjust from solving before it's calculation level has been correctly set. 26. Set the Adjust to vary the first stage outlet pressure (Adjusted Variable), until the calculated duty ratio (Target Variable) is 1. Figure 12



27. On the Parameters tab set the following values: In This Cell...



Enter...



Method



Secant



Tolerance



1 x 10^-3



Step Size



50 kPa (7.25 psia)



Minimum



3000 kPa (435.11 psia)



Maximum



7000 kPa (1015.3 psia)



Maximum Iterations



50
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A Brief Introduction to Calc Levels Calc(ulation) Levels are used to determine the order in which streams and unit operations are solved in HYSYS. HYSYS uses a non-sequential solution method (i.e. it can solve both backwards and forwards). Each time the solver is triggered it constructs a list of objects (streams and operations) to solve. This list is arranged in order of the object Calc Level. The lower the calc level of an object the higher it will appear in the list, and hence the earlier it will be solved. When upstream or downstream objects are affected by new calculations they are added to the solver list. The solver continues until all items are solved. The default calc levels are listed in the table below: Item



Calc Level



Material and Energy Streams



500



Ordinary Unit Operations



500



(e.g. Pumps, Heaters, Coolers...) Columns and Sub-flowsheets



2500



Simple Logical Operations



500



(Set and Balance) Complex Logical Operations (Adjust and Recycle)



3500



The Calc Levels of all the objects in a flowsheet can be viewed and changed by going to the Simulation / Main Properties menu option and choosing the Calc Levels tab.
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Figure 13



Hence the default calculation levels for Adjusts and Recycles mean they solve after the rest of the flowsheet, but are at the same level of priority in the solver list. If the target of an Adjust is inside a recycle loop then sometimes the Adjust and Recycle can conflict. In this situation it is best to set the calc level of the Adjust slightly higher so that it solves after the recycle has solved. 28. Change the Calc Level of the Adjust to 4000 so that it solves after the recycles. 29. Unignore the Adjust, it should now solve. What inter-stage pressure balances the compressor loads? ________________________________________________________________
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Exploring with the Simulation Since the two Recycles in this simulation are interconnected it would make sense to change their Calculation Mode (under Recycle Parameter tab, Numerical page) to Simultaneous rather than Nested. Deliberately displace the simulation from the load balance point (e.g. by changing the inter stage pressure to 40 bar). Compare the solution time between the two calculation modes. Which Calculation Mode makes the simulation solve fastest? ________________________________________________________________ Try tightening all the tolerances to 0.1, What happens now? ________________________________________________________________



The Author found that for a displacement to 40 bar the Nested recycles took around 13 seconds to solve, whereas the Simultaneous recycles solved in just 4 seconds. In this case the step size is probably too small since the Adjust requires many small steps to work up to the solution.



Exercise - Backward Pressure Transfer The Backward transfer feature of the Recycle operation allows the two Sets to be removed. Using the following steps, remove both the Sets in the multi-stage compression sub flowsheet.
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1.



Ensure the upstream pressure is propagated into the recycle outlet stream by changing the mixer pressure assignment mode to 'Equalize All' (Design / Parameters page).



2.



Change the Transfer Direction on the Recycle (Parameters / Variables page).



3.



Delete the Set.



4.



Move the assumed value from the Recycle outlet stream to the inlet stream.
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Challenge You complain to your boss, Grayson Streed, that your simulation takes too long to converge on your computer because of the multiple recycles and use this opportunity to petition for a new high-speed computer. Grayson has a look at your simulation and denies your request on the basis that you can reduce your convergence time by eliminating one of the recycles in the simulation. Is your request justified or is Grayson correct? Hint: visualize the two recycle loops in the case, and try to see if there are any overlaps. If you find that Grayson was right, eliminate one of your recycles. Think carefully about the best way to proceed. Remember that you'll need to provide an initial estimate of the recycle outlet stream. What is the best way to obtain this estimate? With one recycle eliminated how long does the simulation take to recover from a disturbance now?___________________________________________



Exercise - Using Simultaneous Adjusts It has been decided to split the export gas flow between the multi-stage export gas compression system and the existing single stage export gas compressor. There is a fixed product gas flow requirement of 100 MMSCFD from the multi-stage compression plant. The requirement to set the interstage pressure so that the compressor duty is balanced still holds. This will require the following modifications to the case: • •



Remove the current multiple stream connections on stream 13 and add a Tee to split the flow between the two export gas compression systems. Add an Adjust to vary the feed gas flow to the multi-stage compression system.



The compression sub-flowsheet will therefore have two Adjust operations. Since changing either adjusted variable (feed gas flow or interstage pressure) will effect both target variables (compressor load balance and product gas flow), if the Adjusts are left with the standard 35
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solving method they may interfere with each other while they are solving. This is because each Adjust considers only its adjusted and target values, and does not cooperate with any of the other adjusts. To prevent this interference the Adjusts can be set to solve simultaneously. This uses a different solution algorithm, which makes the Adjusts solve cooperatively at the end of each flowsheet calculation step. Use the following steps to adapt your existing model. 1.



Break the connections between the main flowsheet stream 13 and the main flowsheet export gas compressor (K-102), and the multistage compression sub-flowsheet.



2.



Insert a Tee, reconnect the streams as below. Remember the Feed gas from the main flowsheet (labelled To multi-stage comp) should be connected to the stream currently called From Main Case on the sub-flowsheet. Figure 14



MMSCFD is one of the available units for the Molar Flow variable type, it uses the volume of an ideal gas at standard conditions to do the conversion.
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3.



Enter an initial flow of 2500 kgmole/h in the sub-flowsheet To multistage comp stream.



4.



Add an Adjust to the sub-flowsheet to vary this flow rate with a target value of 100 MMSCFD in the New Export Gas stream.



5.



Set both Adjusts in the sub-flowsheet to use the Simultaneous Solution method. (This is accomplished using a checkbox on the Parameters tab.)
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Start the Adjusts solving What feed flow rate is required to give an export gas flow of 100 MMSCFD?___________________________________________



The Simultaneous Adjust Manager (SAM) allows all the simultaneous adjusts in the case to be controlled in one place. The SAM can be accessed via a button on each Adjust or from the Simulation menu. Figure 15



The Configuration tab shows the set-up of each of the Simultaneous Adjusts, you can view the individual Adjust windows by clicking on their names. The History tab shows iteration-by-iteration results for each Adjust.
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Parameters Tab The Parameters tab allows you to modify the tolerance, step size, and max and min values for each Adjust. It also displays the residual, number of iterations the SAM has taken and the iteration status. This tab also allows you to specify some of the calculation parameters as described in the table below: Parameter
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Description



Type of Jacobian Calculation



Allows you to select one of three Jacobian calculations: • ResetJac. Jacobian is fully calculated and values reset to initial values after each Jacobian calculation step. Most time consuming but most accurate. • Continuous. Values are not recalculated between Jacobian calculation steps. Quickest but allows for ‘drift’ in the Jacobian therefore not as accurate. • Hybrid. Hybrid of one of the above two methods.



Type of Convergence



Allows you to select one of three convergence types: • Specified. SAM is converged when all Adjusts are within the specified tolerances. • Norm. SAM is converged when the norm of the residuals (sum of squares) is less than a user specified value. • Either. SAM is converged with whichever of the above types occurs first.



Max Step Fraction



The number x step size is the maximum that the solver is allowed to move during a solve step.



Peturbation Factor



The number x range (Max - Min) or the number x 100 x step size (if no valid range). This is the maximum that the solver is allowed to move during a Jacobian step.



Max # of Iterations



Maximum number of iterations for the SAM.
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Answer Key Exercise 1 Examine the PFD above. This Flowsheet has three physical recycles and three HYSYS recycle operations. What is the minimum number of recycle operations that are needed?



One. Three are 3 separate loops and they overlap in stream 1 (Hint: Visualise the separate loops in the system. Which stream is included in all the loops?) Where should the recycle operation(s) be positioned?



At the outlet of the mixer



Exercise 2 How many recycles are needed in this flowsheet, where should they be placed, and why?



There is no need for a Recycle operation in this refrigeration loop flowsheet due to the positioning of the specifications.



Exercise 3 How many recycles are needed in this flowsheet, where should they be placed, and why?



Again, there is no need for a Recycle operation. The column feed stream is fully defined even though Exchanger E-100 hasn't completely solved, hence the column can solve and then E-100 can solve.
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Exercise 4 How many recycles are needed in this flowsheet, where should they be placed, and why?



There is no need for a Recycle in the small loop containing the two exchangers and separator V-101 because the pressures and temperatures in streams 3 and 4 are known, hence stream 4 can flash fully before the exchangers are solved. However, the column will not be able to solve unless its feed stream is fully defined, hence a Recycle is need somewhere in the main loop for example in stream 9, 1 or 7.



Exercise 5 How many recycles are needed in this flowsheet, where should they be placed, and why?



The column requires both feed streams to be fully defined before it will solve, hence a Recycle is required in each of the two loops, for example a recycle in stream 4 and another in stream 1.
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Exercise 6 Questions (page 19) Examine the PFD of a three stage compression plant above. This Flowsheet has five physical recycles and six HYSYS recycle operations. What is the minimum number of recycle operations that are needed?



Three To answer this question consider all the information about recycle positioning in this module, and note the following: • All the Exchangers in the PFD have pressure drops defined • E103 has a UA specified • E104 has an outlet temperature specified.



Where should the recycle operation(s) be positioned?



See the PFD below for suggested positioning. Recycles 1 and 2 can be combined at the outlet of the mixer. Recycle 5 is superfluous since the first feed separator can solve fully with the other Recycles in place. Recycle 3 can be positioned anywhere in the loop containing the liquid return from the first stage of compression and the vapour produced from the second feed separator. Here it has been moved to one of the main streams as this is likely to be a more stable. (Larger flows and less fluctuation of flow rate as the case solves.) Likewise Recycle 4 has been moved to one of the main streams. Recycle 6 is also superfluous since both feed streams to E-103 are fully defined as E-104 has a specified outlet temperature.
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Workshop In this module, you will be presented with cases derived from the HYSYS Steady State course. There have been errors introduced into the cases that prevent them from solving. It is left up to you to find these errors and solve the cases. Of course, the instructor will be willing to assist you in any way that he/she can. In order to save time, all of the cases can be found on the supplied Starter disk. The solved cases are also provided on the Solutions disk. Also included in this module are several troubleshooting tips that you can use both for this module and for troubleshooting your own cases.



Learning Objectives After competing this module, you will be able to: • • •



Troubleshoot existing HYSYS cases Recognize common problem areas in a HYSYS case Understand the message HYSYS gives after a consistency error occurs



Prerequisites Before beginning this module, you should be able to: • •
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Navigate the PFD and Workbook Environments Add and delete specifications for various unit operations
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General Troubleshooting Tips These tips are given here to help you complete this module, but they are generic so that they can be used when troubleshooting almost all HYSYS simulations. This list was compiled with the help of the Technical Support department and contains several of the problems that they encounter on a daily basis. 1.



Always check that the solver is not in "Holding" mode. Whenever a consistency error is encountered in the simulation, the solver is placed in this mode. When the Holding mode is active, streams and operations that are not solved can appear to be solved, and vice versa; this can make the troubleshooting process quite difficult. When the solver is holding, "Holding..." will appear in the HYSYS status bar and the focus will be on the red "traffic light" in the tool bar. The solver can be returned to "Active" by clicking the green "traffic light."



2.



Carefully examine all consistency error messages that HYSYS provides. They can often help you find the source of the error. All Consistency Errors will look something like this. Figure 1
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3.



Always debug simulations in the direction of the process flow. For example, if the feed streams enter on the left and product streams exit on the right, debug from left to right. It is important that upstream operations be error-free before you attempt to debug downstream operations.



4.



The HYSYS Workbook is a handy debugging tool. You can quickly determine which simulation variables are user specified (blue) and which are calculated (black). Remember that in order for the workbook to accurately represent actual conditions, the solver must not be in "Holding" mode.



5.



Make sure that all required streams are fully specified. All column feed streams and, usually, all process feed streams are fully defined. Make sure all assumed values in Recycle operations are fully defined. In most cases these will be in the outlet stream, unless the recycle is set to transfer information backwards.



6.



Use the HYSYS Status window and Trace window to their full potential when debugging HYSYS simulations. Carefully monitor all messages in both windows; pay special attention to messages in red or blue type.



7.



Check that no operations or streams are hidden or ignored. Ignored operations will not be solved, and hidden operations can affect other operations in the simulation resulting in errors. To determine if a case has any hidden objects, and to unhide them, right click on the PFD background and choose Reveal Hidden Objects …



8.



When dealing with Adjust operations there are several items to remember. • • •
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Make sure that the step size and tolerance values are reasonable. Use maximum and minimum values to limit the operation. The adjusted variable must be user-specified or a consistency error will result.
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Using the Property Balance Utility to Check Overall Mass and Energy Balances The property balance utility displays material and energy balances across the whole flowsheet or across selected operations. It can be useful for troubleshooting. To add a property balance utility: 1.



Open the Tools-Utilities menu, or press CTRL U. The Available Utilities view appears.



2.



Select the Property Balance Utility. Figure 2



5



6



Troubleshooting



3.



Click the Add Utility button. The Property Balance Utility view appears. Figure 3



Next, you must choose the scope for the utility. 1.



Click the Scope Objects button.



2.



To select the whole flowsheet as the scope, select Case. (Ensure the Object Filter is set to the FlowSheet Wide radio button as shown.) Figure 4
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Select the required flowsheet, and press the >>>>>> button as shown. Figure 5



Notice that FlowSheetWide appears in your Scope Objects list.



Alternatively the balance can be limited to selected operations.



4.



Click the Accept List button.



5.



Next choose variables to include in the material balance by using the Insert Variable button.



To view material balance results, click the Material Balance tab and select the Balance Results radio button. Figure 6
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To view energy balance results, click the Energy Balance tab. Figure 7



Column Troubleshooting Tips Columns are the key operations in many HYSYS simulations, and because their operation is more complex than most HYSYS operations, a separate section of this module is dedicated to tips that you can use to converge all types of column operations.
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Degrees of Freedom Degrees of freedom play an important role in the operation of the HYSYS solver, but their role is most obvious when working with column operations. The DOF can be checked on the Monitor page. They must be zero before the column solver will attempt to converge the column. The number of active specifications that the column requires depends on the configuration of the column and can be determined using this formula: # of active specs = # of side exchangers + # of side draws + # of pumparounds + # of side strippers



(1)



In the above formula, reboilers and condensers (any type) are counted as side exchangers. What will be the required number of active specifications for a column operation with a condenser, three side strippers, three pumparounds, and no reboiler? _________________________________________________________



This is a tricky question because many people forget that each pump around and side stripper also has its own individual side draw. So the actual number of required active specifications is 13, not 7.



When you are defining the active specifications for your column operations, ensure that you are not entering conflicting specifications. For example, with a generic distillation column (a condenser and a reboiler) do not specify both the reboiler duty and overhead rate as active specifications. These values are linked and are really the same specification; so specifying both as active will probably not allow the column to solve. It is also a good idea to spread the active specifications between the top of the column and the bottom. For example, do not specify the condenser temperature, overhead vapour rate, and reflux ratio as your three active specifications. These specifications all focus on the top of the column; it would be much better if the three specifications were reflux ratio, bottoms draw rate, and overhead vapour rate. This means that the bottom of the column will be partially specified as well.
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Another common mistake is that the HYSYS user will specify the product flow rates as their active specifications. This is commonly done when attempting to model an existing column because product flow rates are often readily available. The problem here is that if all of the product flow rates are fixed, HYSYS has no flexibility in determining a solution. It is much better to specify the flow rates as estimates, and use other specifications as the active specs. Temperature estimates are not required for most columns; however, if they are specified, you may find that the column will converge faster. If you use temperature estimates in your simulations, remember to enter values for the top stage and bottom stage temperatures only; however, if a condenser is used as stage 1, enter a stage 2 temperature also. Often a steam feed is used to supply energy to the bottom stage in a column. If a steam feed is used, remember to attach a water draw at an appropriate location on the column to remove the excess water. All feed streams to a column must be fully defined before the column can solve. Columns can not calculate the conditions of a feed stream based on product streams. Likewise, all product streams should not contain any user specified information. A product flowrate specification must be listed with the column’s other specifications on the Monitor page, not specified as the flow rate for that stream in the worksheet. The configuration of a column must be defined before the column can solve. This means that the following items must be fully defined: • • • • •
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All feed streams and their respective feed locations Number of Ideal Stages The Tower Pressure - specify both a top stage pressure and a bottom stage pressure. If stage 1 is a condenser, specify a stage 2 pressure (a condenser pressure drop) also. The Type of Tower - Contactor, Refluxed Absorber, Reboiled Absorber, or Distillation. Location and number of side strippers, pumparounds, and side draws, if applicable.



Troubleshooting



11



Column Diagnostics Once all of the required information is entered and the column solver is able to begin calculations, there is no guarantee that the given specifications will lead to a solved column. As many HYSYS users are aware, finding the specific reason for convergence failure can be a difficult and frustrating challenge. The following five situations can occur if the column fails to converge. Each situation has possible causes, which may help you find the source of the problem. Condition 1 - The Column fails almost immediately after start-up: • • • •



A vapour-liquid mixture may not be possible at tower conditions. Check BP and DP of all feed streams at tower pressures and ensure that a V-L mixture is possible. The mass balance around the column is failing. Check that the product flow estimates (specifications) do not sum to a value that is greater than the feed flowrate. A component specification exists for a component that does not exist in the feed stream. Columns with no condenser must have a top stage liquid feed, and columns with no reboiler must have a bottom stage vapour feed.



Condition 2 - The Heat and Spec Error fails to converge: •



The column may be unable to meet the desired purity specifications. If this is the case, increase the number of stages.



Condition 3 - The Heat and Spec Error oscillates and fails to converge: • •



If the components in the column have similar bubble points, allow looser component specs. This condition can also result from a build-up of water in the column, which can be solved by adding a side water draw. This is usually added to the condenser, but may be added at any stage.
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Condition 4 - The Equilibrium Error fails to converge. • •



Check that the top stage calculated temperature is not too cold. If it is, a side water draw may be required. Check the material balance around the column, make sure that your specifications are not preventing the column from solving.



Condition 5 - The Equilibrium Error oscillates and fails to converge: •



This occurs most often with non-ideal towers. In these cases, convergence may be reached by changing the damping factor to a number between 0.4 - 0.6. Another option is to set the damping factor at "Adaptive" rather than "Fixed". This will allow HYSYS to determine its own damping factor.



Working on Cases This is your opportunity to apply the tips that were presented on the previous pages. The instructor will let you work through the problems individually; however, if you require assistance, please, ask the instructor for help.



Case 1 Open the HYSYS case called Case 1.hsc located on the Starter course disk. This case is a multi-stage compression plant with liquid recycled upstream.
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Process Flow Diagram - Case 1
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Attempt to solve the case by adding and deleting specifications as needed. It is a good idea not to delete anything too quickly as you may need the value later on. It is also a good idea to begin at the very beginning of the simulation and work you way through to the end. After opening the case, you may notice that it is in Holding mode. To resume the calculations, click the "Green Light" button in the Main Menu Bar.



There are errors in three places in this simulation that must be removed before the simulation will solve.



What was the first thing that you changed? _____________________________



The second? _________________________________________________________



The third? ___________________________________________________________



Case 2 Open the HYSYS case called Case 2.hsc located on the Starter course disk. This case is a simple gas plant where the separator temperature is set to meet a dew point temperature specification on the export gas.



14



Process Flow Diagram - Case 2



16



Troubleshooting



In this case, there are five errors distributed among three operations. Start at the beginning of the simulation; remove all of the errors and solve the simulation. In order to solve this simulation, you need to think about the purpose of the Balance operation, and the solving behaviour of the Adjust operation. The balance operation can perform material and energy balances over it's connected streams. If the Mole balance type is chosen then component mole flows are balanced, the Mass balance type balances overall mass flows. What was the first thing that you changed? _____________________________



The second? _________________________________________________________



The third? ___________________________________________________________



The fourth? _________________________________________________________



And the last thing that you changed? __________________________________



Case 3 Open the HYSYS case called Case 3.hsc located on the Starter course disk. This case simulates demethaniser and deethaniser columns.
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Process Flow Diagram - Case 3
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Troubleshooting



In this case, there are four errors that prevent the two columns from converging. It is important to remember what a column needs in order to solve. Once again, start at the very beginning of the simulation and work your way through the case. What was the first thing that you changed? _____________________________



The second thing? ____________________________________________________



The third thing? _____________________________________________________



And the last thing that you changed? ___________________________________



Case 4 Open the HYSYS case called Case 4.hsc located on the Starter course disk.
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Process Flow Diagram - Case 4
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Troubleshooting



In this case, there are only two things that must be changed, finding the errors could prove challenging; things are not always as they appear. Remember to think twice before deleting anything; once it is gone, you might not be able to get it back. In this case, it will help to consider the purpose of every operation. What operation contained both problems? _____________________________



Why did you change in this operation?_________________________________



Why does this operation need to be specified in this manner? ____________
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Depressurisation: A Practical Guide This guide has been prepared based upon questions frequently asked regarding the Dynamic Depressuring utility introduced in HYSYS 3.0. It should provide users with an explanation how to use the utility and correctly interpret the results. It is divided into three sections: 1.0 Overview 2.0 Adding and Configuring the Utility 3.0 Example Problem



1.0



Overview



Why are there two Depressuring utility options? The original Depressuring utility in HYSYS was a pseudo-dynamic calculation based on a series of steady state calculations. The Dynamic Depressuring utility was introduced in HYSYS 3.0 to allow users to perform proper time-dependant calculations. A HYSYS Dynamics licence is NOT required to use this new utility. What can this utility be used for? The Depressuring utility can be used to simulate the depressurisation of gas, gas-liquid filled vessels, pipelines and systems with several connected vessels or piping volumes depressuring through a single valve. References to “vessel” in this guide can also refer to piping or combinations of the two. What types of depressuring calculations can be performed? There are two major types of depressuring calculations available: •



Fire Mode is used to model a vessel or pipe under fire conditions. This mode has three sub-types: Fire, Fire Wetted and Alternative Fire.



•



Adiabatic Mode is used to model the blowdown of pressure vessels or piping with no external heat supplied.



A more in depth discussion of the different methods follows in Section 2.0.



2.0



Adding and Configuring the Utility



How to add the utility A Depressuring utility can be added to the case by selecting "Tools" ! "Utilities", highlighting "Depressuring - Dynamics" and pressing the "Add Utility" Button. You may note that the original Depressuring model is still shown on the "Available Utilities" menu, this option will be discontinued after version 3.0.1 and all existing models will be converted to the new Dynamic utility.



Connections



Hyprotech Technical Support Knowledge Base Article



1



How to connect the utility to a stream On the "Design" tab, "Connections" page, choose the stream that represents the fluid you want to use as the source for the depressuring. If you have a single vessel, for example, the stream would be the feed stream into the vessel. Attaching the stream to the utility is accomplished as shown in the view below.



Press the arrow and select the inlet stream from the drop-down list.



Entering Vessel Parameters Ideally, the vessel size will be known and this data can be entered into the appropriate fields on the form shown above. If the vessel size is unknown, then the vessel sizing utility in HYSYS can be used to estimate the required parameters. The initial liquid volume is normally calculated at the normal liquid level (NLL). The heads of the vessel are not taken into account so the volume will be the liquid in the cylindrical portion only. If the feed stream is two-phase, the equilibrium composition of the liquid will be calculated. If an initial liquid volume is not specified, HYSYS will take a volume equal to the volumetric flow of the feed liquid over one hour. This may be disproportionate to the total vessel volume. HYSYS does not take account of the heads in a vessel so volumes and areas are calculated as for a cylinder. The total vessel volume is calculated from the diameter and height (or length for a horizontal vessel). To account for piping or head volume contributions, a small amount can be added to the height or length of the vessel. If the condition of the system at settle out are such that the vapour is superheated, HYSYS will not allow a liquid inventory. The settle out conditions for mixed sources and volumes are calculated on a constant enthalpy, volume and mass basis. Correction Factors allow for adjustments to the amount of metal in contact with the top or bottom of the vessel. This can also be used to account for additional nozzles, piping, strapping or support steelwork in close contact with the vessel. HYSYS will use the heat content of this metal when performing the Hyprotech Technical Support Knowledge Base Article
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calculations. This is analogous to adding, for example, ten percent to the vessel mass to account for fittings.



Configure Strip Charts When the Depressuring utility is run, all data is stored using strip charts. Three default strip charts are added when the utility is added. It is possible to remove variables by deselecting the appropriate variable in the "Active" column. A variable can be added by pressing the "Add Variable" button and selecting it from the list of simulation variables. Any configuration to the strip charts should be done before the utility is run, otherwise any new variables will not be stored.



To view data in tabular form, press the "View Historical Data…" button.



To view data in graphical form, press the "View Strip Chart…" button.



Heat Flux Parameters On this page, the type of depressuring to be performed is specified. The different modes and their respective equations are described here.



•



Fire Mode can be used to simulate plant emergency conditions that would occur during a plant fire. Pressure, temperature and flow profiles are calculated for the application of an external heat source to a vessel, piping or combination of items. Heat flux into the fluid is user defined using the following equation:



Q = C1 + C2 × time + C3 (C4 − TVESSEL ) + C5 ×



LiquidVolumetime=t LiquidVolumetime=0



The Fire equation can also be used to simulate the depressuring of sub-sea pipelines where heat transfer occurs between seawater and the pipeline. If C3 was equal to UA, C4 was equal to T1 and C1, C2 and C5 were equal to zero, the above equation would reduce to: Hyprotech Technical Support Knowledge Base Article
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Q = UA(∆T )



•



Fire Wetted Mode uses similar heat flux parameters to those used in Fire mode. Three coefficients: C1, C2 and C3 must be specified. The equation used by HYSYS is an extension to the standard API equation for heat flux to a liquid containing vessel. A wetted area is required and used to calculate the heat transfer into the vessel. The following notes are based on extracts from Guide for Pressure-Relieving and Depressuring System, API Recommended Practice 521, Forth Edition, March 1997. The amount of heat absorbed by a vessel exposed to an open fire is affected by: a) The type of fuel feeding the fire b) The degree to which the vessel is enveloped by the flames (a function of size and shape) c) Any fireproofing on the vessel The following equations are based on conditions where there is prompt fire fighting and adequate drainage of flammable materials away from the vessel. API Equation (field units)



Q = 21000 × F × A0.82



Q = total absorption to wetted surface (BTU/h) F = environmental factor A = total wetted surface (ft2)



API Equation (metric units)



Q = 43.116 × F × A0.82



Q = total absorption to wetted surface (kJ/s F = environmental factor A = total wetted surface (m2)



Environmental Factor Table 5 on Page 17 of API 521 lists F factors for various types of vessels and insulation. For a bare vessel, F = 1. For earth-covered storage, F = 0.03. For below-grade storage, F = 0. For insulated vessels, users should consult the reference and select an F value based on the insulation conductance for fire exposure conditions.



Wetted Area The surface area wetted by the internal liquid content of the vessel is effective in generating vapour when the exterior of the vessel is exposed to fire. To determine vapour generation it is only necessary to take into account that portion of the vessel that is wetted by liquid up to 7.6m (25ft) above the source of the flame. This usually refers to ground level but it can be any level capable of sustaining a Hyprotech Technical Support Knowledge Base Article
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pool fire. The following table indicates recommended volumes for partially filled vessels. Volumes above 7.6m are normally excluded as are vessel heads protected by support skirts. Type of Vessel



Portion of Liquid Inventory



Liquid full (e.g.: treaters) Surge drums, knockout drums and process vessels



All (up to 7.6m)



Fractionating columns Working storage Spheres and spheroids 1



Normal operating liquid level (up to 7.6m) Normal level in the bottom plus liquid hold up from all the trays dumped to the normal level in the column bottom. Total wetted surface only calculated up to 7.6m 1 Maximum inventory level (up to 7.6m) Either the maximum horizontal diameter or 7.6m, whichever is greater



Reboiler level is to be included if the reboiler is an integral part of the column.



The HYSYS equation is an extension of the standard API equation. Therefore, in field units, C1 will be 21000 multiplied by the environmental factor, F and C2 will 0.82. (In most cases, C1 will be equal to 21000).



Q = C1 × (WettedAreatime=t )



C2



Wetted area at time t is defined by the following equation:



  LiquidVolumetime=t   WettedAreatime=t = WettedAreatime=0 × 1 − C3 ×  1 − LiquidVolu me time =0    
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The following table is an example showing how the C3 term affects the wetted area calculation. An initial liquid volume of 6m3 and a wetted area of 500 m2 were given.



Time (minutes)



Liquid Volume (m3)



Volume Ratio



0 5 10 15



6 4 3 2



1.0 0.7 0.5 0.3



C3 1 0.75 0.5 0.25 0 Wetted Area Wetted Area Wetted Area Wetted Area Wetted Area (m2) (m2) (m2) (m2) (m2) 500.0 500.0 500.0 500.0 500.0 333.3 375.0 416.7 458.3 500.0 250.0 312.5 375.0 437.5 500.0 166.7 250.0 333.3 416.7 500.0



Therefore if a C3 value of 0 is used, the initial wetted area is used throughout the calculations. This could represent a worst case scenario. Alternatively, if a C3 value of 1 was used, the volume would vary proportionally with the liquid volume. This would represent a vertical vessel. HYSYS 3.0.1, Build 4602 KNOWN ISSUE Depressuring Heat Flux Equation is incorrect if Field units are selected. If the fire wetted equation is used while field units are selected (i.e.: BTU/h), the heat flux equation used by the Depressuring utility will be incorrect. There is a problem with the conversion between SI and Field units. Instead of using the normal API coefficient of 21000, the value of C1 should be multiplied by 7 (i.e.: 147000). This will correct for the unit conversion problem. Because of this defect, the following equations should be: API Equation Equation Units Area Units BTU/h ft2 Q = 147000 * F A 0.82 KJ/h m2 Q = 155201 * F A 0.82 KJ/s m2 Q = 43.116 * F A 0.82 •



Alternative Fire Mode uses the Boltzman constant to take into account radiation, forced convection, flame temperature and ambient temperature. The method may be considered as an alternative method to the API standard.



(



(



)



)



Q = Atotal × ε f × ε v × k (T f + 273.15 ) − (TV + 273.15 ) + outsideU × (Tamb − TV ) where: A total εf εv k Tf Tv outside U Tamb
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4



= total wetted surface area = flame emissivity generally ranges from 0.2 to 0.5 (for burning heavy HCs) = vessel emissivity generally ranges from 0.5 to 1 (for polished metal) = Boltzman constant equals 5.67*10 - 8 W/m2 K4 = flame temperature 1500 K and upwards = vessel temperature = convective heat transfer between vessel and air = ambient air temp
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•



Adiabatic Mode can be used to model the gas blowdown of pressure vessels or piping. No external heat is applied so no parameters need to be entered in this section. Heat flux between the vessel wall and the fluid is modelled as the fluid temperature drops due to the depressurisation. Typical use of this mode is the depressuring of compressor loops on emergency shutdown.



•



Use Spreadsheet is an option that allows the user access to the spreadsheet used by the depressuring utility. Values can be altered in this spreadsheet and additional equations substituted for calculation of the heat flux. It is recommended that this option only be used by advanced users.



Heat Loss Parameters There are three types of Heat Loss models available: 1. None: does not account for any heat loss 2. Simple: allows the user to either specify the heat loss directly or have it calculated from specified values 3. Detailed: allows the user to specify a more detailed set of heat loss parameters



Simple Model Hyprotech Technical Support Knowledge Base Article
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•



An overall U value can be specified in this section.



•



Heat Transfer Area is the cylindrical area of the vessel with no allowance for head area. This value is calculated using the vessel dimensions specified on the "Connections" page.



•



Using the Simple Heat Loss Model, heat loss from the vessel is calculated using the following formula:



Q = UA(T fluid − Tambient )



Detailed Model The duty can be applied to the vessel wall or directly to the fluid. The former would be used to model a fire and the latter to model a heater. There are four portions of the model to be set up. They are General, Conduction, Convection and Correlation Constants. General The General section allows the user to manipulate Recycle Efficiencies and the ambient temperature.



The default value for all three Recycle Efficiencies is 100%. This means that all material in the vessel has been flashed together and is in thermodynamic equilibrium. If the Recycle Efficiencies were to be reduced a portion of the material would by-pass the flash calculation and the vapour and liquid would no longer Hyprotech Technical Support Knowledge Base Article
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instantaneously reach equilibrium. In this case, the phases may have different temperatures. Unfortunately, there is no single typical number suggested for these parameters. The best option would be to try various scenarios and observe the results. Conduction The Conduction parameters allow the user to manipulate the conductive properties of the wall and insulation.



The metal wall thickness must always have a finite value (i.e.: it cannot be ). To model a vessel without insulation, the insulation value thickness should be zero. Users are also required to enter the specific heat capacity of the material(s), the density of the material(s) and the conductivity of the material(s). Some typical values for metals are: Metal



Density 3



Mild steel Stainless steel Aluminium Titanium Copper Brass



kg/m 7860 7930 2710 4540 8930 8500



Specific Heat



Thermal Conductivity



kJ/kg K 0.420 0.510 0.913 0.523 0.385 0.370



W/m K 63 150 201 23 385 110



Convection The Convection view allows users to manipulate the heat transfer coefficient for inside and outside the vessel as well as between vapour and liquid material inside the vessel.
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To use a set of fixed U values, the "Use Fixed U" option should be selected. If the U values are unknown, the user can press the "Estimate Coefficients Now" button and have HYSYS determine the U values. In order to have HYSYS vary the U values throughout the depressuring scenario, select the "Continually Update U" value. Correlation Coefficients This feature gives users the opportunity to manipulate the coefficients used in the heat transfer correlation. By selecting "Use Specified Constants", the user may manually enter the constants used in the heat transfer correlations.



The equation which determines the outside heat transfer coefficient for air is:



 ∆T   h = C ×  length  



m



The equation used for the other three correlations is:



Nu = C × (Gr × Pr )



m
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Where:



Nu = Nusselt Number Gr = Grashof Number Pr = Prandtl Number



Valve Parameters The Valve Parameters page allows users to select the type of valves to be used for both vapour and liquid service. In most cases, either the Fisher or the Relief valve should be used for valve sizing. Their equations are more advanced than some of the others and can automatically handle choked conditions. Furthermore, these two valve types support other options that can be accessed through the valve property view accessible through the Depressuring sub-flowsheet. The seven available valve types are described in the sections that follow.



Fisher The Fisher option uses the standard valve option in HYSYS. It allows the user to specify both valve Cv and percent opening. By pressing the "Size Valve", the valve can be sized for a given flow rate.
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Once the appropriate Sizing Conditions have been entered, press the "Size Valve" button to have HYSYS determine the valve Cv.



Relief Valve The relief valve option uses the standard HYSYS relief valve. The user can specify orifice area (or diameter), relief pressure and full open pressure. The user is required also to specify an orifice discharge coefficient. To have the relief valve open at all times, enter a full open pressure that is lower than the final expected vessel pressure and a set pressure that is only slightly lower than the full open pressure.



Supersonic The supersonic valve equation can be used for modelling systems when no detailed information on the valve is available. The discharge coefficient (Cd) should be a value between 0 and 1. The area (A) should be a value between 0.7 and 1. P1 refers to the upstream pressure and ρ1 the density.



F = C d × A × (P1 × ρ 1 )



0.5



Subsonic The subsonic valve equation can also be used for modelling systems when no detailed information on the valve is available but the flow is sub-critical. This can occur when the upstream pressure is less than
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twice the backpressure. The discharge coefficient (Cd) should be a value between 0 and 1. The area (A) should be a value between 0.7 and 1. P1 refers to the upstream pressure and ρ1 the density.



 (P + P )× (P1 − Pback )  ρ1  F = Cd × A ×  1 back P 1  



0.5



Pback refers Back Pressure



It is possible to have the depressuring scenario cycle between pressure build-up and relief. To perform this analysis, ensure a reasonable pressure differential and increase the number of pressure steps. Masoneilan This equation was taken from the Masoneilan catalogue. It can be used for general depressuring valves to flare. When this option is selected, the user must specify Cv and Cf. The remaining parameters in the equation are set by the Depressuring utility.



F = C1 × Cv × C f × Y f × (P1 × ρ1 )



0.5



where: C1 Cv Cf Yf y P1 ρ1



= = = = = = = =



1.6663 (SI Units) 38.86 (Field Units) valve coefficient (often known from vendor data) critical flow factor y - 0.148y3 expansion factor upstream pressure upstream density



General The General valve equation is based on the equation used to calculate critical flow through a nozzle as shown in Perry's Chemical Engineers' Handbook 1. It should be used when the valve throat area is known. Note that this equation makes certain limiting assumptions concerning the characteristics of the orifice.



F = Cd × Av × K term × (g c × P1 × ρ1 × k )



0.5



where: Cd Av



= =



discharge coefficient throat cross sectional area



Kterm



=



 2  2( k +1 )    k + 1



k +1
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k P1 ρ1 1



= = =



ratio of specific heats (Cp/Cv) upstream pressure upstream density



Page 5-14, Equation 5.20 (6th Edition) & Page 10-15, Equation 10.26 (7th Edition)



No Flow This option indicates that there is no flow through the valve. Use Spreadsheet Recommended only for advanced users, this option allows the user to customise a valve equation by editing the valve spreadsheet found inside the Depressuring sub-flowsheet. Pressing the "View Spreadsheet…" button will open the spreadsheet.



Discharge Coefficient When the relief, supersonic, subsonic or general valve is selected, the user is required to specify a discharge coefficient. This correction factor accounts for the vena contracta effect. Values ranging from 0.6 to 0.7 are typically used. In order to disregard this effect, set the discharge coefficient equal to 1.



Options Hyprotech Technical Support Knowledge Base Article
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"PV Work Term Contribution" refers to the isentropic efficiency of the process. A reversible process should have a value of 100% and an isenthalpic process should have a value of 0%. For gas-filled systems, values range from 87% to 98%. For liquid filled systems the number ranges from 40% to 70%. A higher isentropic efficiency results in a lower final temperature.



Operating Conditions Operating Parameters Operating pressure refers to the initial vessel pressure. By default, this value is the pressure of the inlet stream. The time step size refers to the integration step size. It may be a good idea to reduce the step size if the flow rate is significantly larger than the volume or if the vessel depressurises in a relatively short amount of time (~3s).



Vapour Outlet Solving Option Either the Dynamic Depressuring utility can solve for the final pressure or the Cv/Area required to achieve a specified final pressure. The "Calculate Pressure" option uses the specified area/Cv to determine the final pressure. The final pressure is given when the Depressuring Time has elapsed.



"Calculate Area" is available for Relief, Supersonic, Subsonic and General valves. "Calculate Cv" is available for Fisher and Masoneilan valves. The two options differ only in the type of value calculated. Based on API, it is normal to depressure to 50% of the staring pressure or to 100 psig. Before the calculations start, the user must specify an initial Cv or area. If the depressuring time is reached before Hyprotech Technical Support Knowledge Base Article
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the final pressure is achieved, then the calculations stop and a new Cv or area is calculated using the final pressure. The calculations are repeated until the final pressure is reached in the given amount of depressuring time. The user may specify a maximum number of iterations and a pressure tolerance to improve convergence. If the user wishes to stop the calculations at any time, the keys can be used. When the utility has stopped running, the final calculated value is displayed here.



This is the desired final pressure.



Performance Once all the required information has been submitted, a yellow bar that reads "Ready To Calculate" will appear at the button of the Depressuring view.



Press the "Run" button to start the calculations. Once the utility has run, users can go to the "Performance" ! "Summary" page to view the results.
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1.0



Example Problem



Simple Fire Depressuring In the exercise, the required valve size for depressuring a vertical vessel to 50% of its operating pressure in a Fire Wetted case will be calculated. Select the Peng-Robinson equation of state, add the required components and then add a stream with the following properties and molar flows: Stream Name Temperature Pressure



Feed 108 C 1000 kPa



(226.4 F) (145.04 psia)



Component Methane Ethane Propane i-Butane n-Butane i-Pentane n-Pentane n-Hexane



Molar Flow 30.0 kmol/h 30.0 kmol/h 30.0 kmol/h 30.0 kmol/h 30.0 kmol/h 30.0 kmol/h 325.0 kmol/h 30.0 kmol/h



(66.138 lbmol/h) (66.138 lbmol/h) (66.138 lbmol/h) (66.138 lbmol/h) (66.138 lbmol/h) (66.138 lbmol/h) (716.495 lbmol/h) (66.138 lbmol/h)
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To attach the Dynamic Depressuring utility to the stream, open the stream property view, go to "Attachments" ! "Utilities" and press "Create…". Select "Dynamic Depressuring" from the list of available utilities. Press the "Add Utility" button.



3) Select "Dynamic Depressuring"



4) Press "Add Utility"



2) Press "Create…"



1) Go to "Attachments" ! "Utilities"



Enter the following vessel information on the "Design" ! "Connections" page: Variable Name Height Diameter Initial Liquid Volume



SI Units 4.50 m 1.25 m 1.45 m3



Field Units 14.76 ft 4.101 ft 51.21 ft3



Enter the following information on the "Heat Flux Parameters" section of the "Heat Flux" page: Hyprotech Technical Support Knowledge Base Article
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Variable Name Operating Mode Equation Units C1 C2 C3 Initial Wetted Area



Value Fire Wetted kJ/h 0.1394 0.8200 0.0000 4.5 m2 (48.44 ft2)



Enter the following information on the "Valve Parameters" page: Variable Name Vapour Flow Equation Cv % Opening



Value Fisher 10 USGPM 70%



On the "Options" page, enter a PV Work Term of 90%. On the "Operating Conditions" page, select "Calculate Cv" and enter a final pressure of 500 kPa (72.52 psia). Once you have submitted the required information, press the "Run" button to execute the calculations. Explore the strip charts, analyse the results and answer the following questions: What size valve was required to achieve the depressurisation? What is the peak flow through the valve?



kg/h



Using the default values provided, try the "Simple" heat loss model. What Cv is calculated? What is the peak flow?



kg/h



Using the default values provided, try the "Detailed" heat loss model. What Cv is calculated? What is peak flow?



kg/h
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Compressor and Pump Curves



Workshop In this module, compressor and pump curves will be used to model the behaviour of simulated compressors and pumps. Using curves to model these unit operations allows HYSYS to accurately simulate actual plant equipment.



Learning Objectives Once you have completed this module, you will be able to: • • • •



Specify and attach head and efficiency curves to compressors Use single and multiple curves to model compressors Attach head curves to pumps Accurately model existing plant equipment with HYSYS



Prerequisites Before beginning this module, you should have a reasonable understanding of the HYSYS program, and be familiar with adding and basic configuration of Pumps and Compressors.
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Compressor Curves Don’t worry if you haven’t built the case mentioned. The “ADV6_AdvancedRecycles_ Soln.hsc” file contains this case.



Using compressor curves in your HYSYS simulation allows you to accurately model existing plant equipment. You can determine if an existing compressor is able to meet the specifications of your process. Using compressor curves allows HYSYS to calculate heads and efficiencies that are dependant on the flow rate. If the flow rate through the compressor is known to be constant, a single pressure rise and efficiency can be supplied. If, however, the flow rate is expected to change, using a compressor curve will allow HYSYS to calculate new heads and efficiencies based on the current flow rate. This results in greater accuracy in the simulation, and allows HYSYS to more closely model actual plant equipment.



Workshop In this workshop, you will add a set of multiple curves to the K-stage 2 compressor in the Advanced Recycle Module simulation. 1.



On the Parameters page, ensure that the Polytropic and Adiabatic Efficiency boxes both read .



These values must read because the efficiencies will be calculated from the compressor curves, and defining the same value in two places will always result in a consistency error.
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Compressor and Pump Curves



Figure 1



2.



Ignore the Adjust that controls the outlet pressure of the 1st stage (ADJ-1).



3.



On the Curves page (on the Rating tab), select the Adiabatic radio button in the Efficiency group. Click the Add Curve button, and enter the data as shown here: Figure 2



Make sure you use the correct units for the variables, and that you set the units before entering the curve data.
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Instead of manually typing the data you can paste it in from the Excel file 'Compressor Data.xls'. Before the compressor curve window will accept a table of pasted data it must first be set to have the correct number of rows. This can be accomplished by typing dummy data points into the left-hand column to give the required number of rows. Figure 3



Figure 4



5



6



Compressor and Pump Curves



Figure 5



4.



Activate the individual curves on the Curves page and ensure that the Enable Curves box is checked.



The pressure downstream of E-Stage 2 is fixed at 70 bar, so in this case the calculated variable on the compressor is the speed. As an alternative the speed could be specified and the downstream pressure calculated. What is the speed of the machine?



What is the Adiabatic Efficiency?



and the Polytropic Efficiency?
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Compressor and Pump Curves



5.
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Click the Plot Curves button. A graphical view of the curves and operating point is shown. Figure 6



Operating Point



Save your case!



Optional Exercise It is desired to have an outlet pressure of 7850 kPa at the battery limits to the facility (i.e. stream New Export Gas). How can you achieve this? In a normal compressor installation, how would the unit be controlled? What would be set? What would be adjusted? Can you think of a way to simulate this on the present flowsheet?
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Compressor and Pump Curves



Pump Curves As with compressor curves, pump curves are used to allow HYSYS to accurately model existing pumps. Pump curves allow the pressure rise across the pump to be dependent on the flow rate of liquid. The pump curves are entered into HYSYS using a form different to that used for compressor curves. With pump curves the coefficients of an expression, up to the fifth order, are entered into HYSYS rather than the actual data points. Add a pump to the main flowsheet with the following information: Figure 7
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6.
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Ensure the Activate Curves box is ticked. Figure 8



The coefficients can be obtained from a spreadsheet program capable of nonlinear regression, such as EXCEL or may be supplied by the pump’s manufacturer.



What is the outlet pressure of the pump?
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Using Neural Networks in HYSYS



Introduction HYSYS includes a Neural Network calculation tool that can be used to approximate part (or all) of a HYSYS model. It can be trained to replace either the first principles calculations usually done by HYSYS, or to simulate a unit operation that cannot be modeled using first principles. Using a Neural Network solver offers a number of advantages: It is significantly faster than a first principles solution. It offers increased robustness so that a result will always be possible. When using a Neural Network, always be aware that results are valid only within the range over which the Neural network was trained.



Workshop In this module HYSYS’ Neural Network capability will be used to replace the standard HYSYS solver for the Turbo Expander plant that has been constructed in this course. Additionally an Exercise is included where the Parametric Unit Operation is trained with tabular input data.



Learning Objectives After completion of this module, you will be able to: Use the Parametric Utility to incorporate a Neural Network into a HYSYS model. Use the Parametric Unit Operation with tabular data to model a unit operation as a ‘black box’.



Prerequisites Before starting this module you should be familiar with the HYSYS interface and be able to add and configure streams, operations, utilities and case studies.
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Neural Networks What is a Neural Network? A Neural Network (strictly an ‘Artificial Neural Network’ as opposed to a ‘Biological Neural Network’) is a mathematical system with a structure based on that of the brains of mammals. The Artificial Neural Network is split into many basic elements (equivalent to neurons in biological systems), which are linked by synapses. Neural Networks model the relationship between input and output data. They are particularly suited to the kind of problems that are too complex for traditional algorithm based modeling techniques, for example pattern recognition and data forecasting. There are a number of types of Neural Networks, but HYSYS uses a Multi-Layer Perceptron (MLP) type model. The Neural Network is trained through a learning process where synaptic connections between neurons are constructed and weighted. The Neural Network is trained in an iterative manner. A set of input data and desired output data is repeatedly supplied and based on the errors between the Neural Network calculated outputs and the desired outputs, the connections are adjusted for the next iteration.



Neural Networks in HYSYS The HYSYS Neural Network implementation allows part (or all) of the HYSYS flowsheet to be approximated by a Neural Network solver. The Neural Network can either be trained with the results from the standard (first principles) solver, or can be supplied with tabular training data. In this way, it can be used as a ‘black box’ calculation engine based on experimental or plant data. There are two parts to the HYSYS Neural Network implementation: Parametric Utility. This is where the Neural Network is configured, and trained. Parametric Unit Operation (Optional). This allows the Neural Network to appear as a unit operation on the flowsheet, and is typically used when taking a ’black box’ approach.
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Steps for using Neural Networks in HYSYS The procedure for using Neural Networks in HYSYS is as follows: 1. Select scope: determine which streams/operations will be calculated by the Neural Network. 2. Select and configure input and output variables. 3. Supply training data: either tabular data or data generated by the normal HYSYS solver. 4. Train the Neural Network. 5. Validate the Neural Network. This is optional, but recommended.



Workshop Process Description



Don’t worry if you haven’t built the Turbo Expander plant case. The file ‘ADV5_Spreads&CaseS tud_Soln.hsc’ contains this case.



In this module HYSYS’ Neural Network capability will be used to replace the standard HYSYS solver for the Turbo Expander plant that has been constructed in this course. 1. Open the Turbo Expander plant case if it is not already open. This module assumes that the case has had at least the changes from the ‘Templates and Sub-flowsheets’ and ‘Spreadsheets and Case Studies’ modules made to it. The main process variables that will be manipulated are the cooler outlet temperature (stream 2) and the Turbo Expander outlet pressure (stream 5). If you have completed the Advanced Recycles module and have added the multi-stage compression sub flowsheet to your Turbo Expander plant, it is a good idea to ignore the Adjust operations to reduce the calculation time.
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Adding the Parametric Utility 2. From the Tools-Utilities menu, add a Parametric Utility. Name the utility ‘Whole FS NN’.



Setting the Scope The first step in configuring the Parametric utility is to select the scope (i.e., how much of the flowsheet will be calculated using the Neural Network). In this case, the Neural Network will be applied to the whole flowsheet. 3. On the Configuration tab, ensure Case (Main) is selected in the left list box. Click the Add All button. 4. Click Accept List. Notice that now the Next> button is enabled to move the view to the next tab. It is possible to only model a subset of operations in the flowsheet. Operations can be added and removed using the buttons marked >>>>> and 

 View more...
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